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Chapter 1: Introduction

OVERVIEW

What Is It?
Bunkspeed Drive has all the features for the discerning professional graphic 
artist, photographer, marketer, animator, designer and 3D creative.

• Additional photometric light sources and the ability to keyframe animate 
them.

• Configurations to show off your creations in a variety of flavors whether its 
model variants, materials, scenes or cameras.

• 360 spin animation and automatic compilation into .mp4, flash (.flv) for 
web placement or Matroska (.mkv).

• Displacement mapping allowing for that next level detail in materials.

• Multi-layer materials combine up to four materials into a single effect.

• Render passes to help perfectly composite your final images and tweak, 
glossiness, reflectivity, the ground shadow and more.

• Region Render lets you render a region within a camera. You can specify 
different regions for different cameras.

• Wheel building for 4-wheel vehicles.

• Physics engine — including support for dynamic physics on all models, 
and the ability to record and play back dynamic sequences.

• Ability to connect to other machines running Drive and use their rendering 
power.

• Intuitive QUEUE™ allowing off line queued rendering of images and 
animations. (Documentation provided separately.)

• Sun and sky simulation and time of day animation.

• Ability to connect to PowerBoost™ render server. (Documentation 
provided separately.)

• Image post processing features to make your picture "pop" without going 
to Photoshop.
Copyright © Bunkspeed, Inc. 2002-2014 1
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• Multiple Working Viewports: You can show one, two, or four Viewports 
simultaneously. Each Viewport can reference a separate camera, model 
set, and environment.

• Baked environmental lighting per part. Fast too.

• Global Illumination dramatically improves the realism of objects in raster 
views, so as to provide near-raytrace quality in near real-time.

• Models can reflect other models in raster mode.

• Several rendering modes:
– Preview : Quick shots of your scene using your configured cameras.
– Accurate: Full power raytracing with enhanced iRay Photoreal 2014, 

or Stellar (your choice), for superior results (but slower and quite 
noisy for real-time editing).

• Can scale seamlessly to one or more workstations or to a large cluster.

• Works with a wide variety of CAD data.

• Significantly accelerated with the powerful parallel processing power of 
NVIDIA CUDA-enabled GPU's. More CUDA cores gives better 
performance.

• Auto-update of backplates and HDR environment images. When you edit 
a backplate or HDR image in PhotoShop, HDR Light Studio, Filter Forge, 
or similar software, the image is automatically updated in your Bunkspeed 
project.

• In Full Screen Mode (F11), borders and tabs disappear, providing a clean 
view of your scene for presentations and daily use.

• Ability to merge BIF files by dragging and dropping into the scene.

• Ability to move a part to a new group without changing the part’s position.

• Ability to copy-and-paste settings between environment images.

• Numerous supported import formats:
– AliasStudio 2012 and prior (.wire)
– 3D PDF
– 3DXML
– Native SolidWorks 2014 support
– Maya Binary 2014
– Pro/E and CREO plugin
– IGES
– STEP
– Collada (DAE)
– Filmbox (FBX)
– ACIS Kernel
– AutoCAD (DWG/DXF) 2013 and earlier
– Autodesk 3D Studio Max (3DS)
– Autodesk Maya 2013 and prior
– Rhino 4.0 and prior (3DM)
– Wavefront (OBJ)
– SketchUp 8.0 and prior (SKP)
Copyright © Bunkspeed, Inc. 2002-2014 2
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– Inventor 2012 and prior via plugin
– Solid Edge ST3 and prior
– Revit plugin

How It Works
Bunkspeed  DriveSuite is a fully raytraced rendering environment, by default. 
(By changing rendering modes, you can use fast raytracing, or disable 
raytracing entirely, to speed up editing on lower power hardware — and then 
enable full raytracing as a final step.) The software is constantly updating the 
scene using raytracing by taking full advantages of all available CPUs and 
CUDA GPUs.

Unlike traditional 3D applications, you do not need to guess and check before 
generating final results. In Bunkspeed DriveSuite, you interact with the final 
result at all times, even while animating. 

A Bunkspeed  DriveSuite project consists of an environment sphere that 
includes a transparent ground plane for accurate shadowing, and an HDR 
environment image that maps to the spherical environment. No further lighting 
setup is required, although additional sources of light are available.
Copyright © Bunkspeed, Inc. 2002-2014 3
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SYSTEM REQUIREMENTS

Bunkspeed  DriveSuite has the following minimum and recommended system 
requirements.

Configurations and Hardware 
Requirements Bunkspeed  Drive 2014

Realtime Resolution up to 4096 x 2048 (with a 4K display)a

Rendering Resolution unlimited

Operating System
(64bit Windows 7 highly 
recommended)

Windows 8, 64-bit
Windows 7, 64-bit

CPU Minimum Dual Core CPU

CPU Recommended Quad-Core CPU or Higher

Memory Minimum 4GB of RAM

Memory Recommended 8+GB of RAM, 64bit OS

Disk Space 1 GB or more (for application + assets)

Graphics Cards Budget 
(untested) (256+ CUDA cores,
2+ GB Graphics Memory.
Dual graphics cards are highly 
recommended for pro level 
performance. 3 GB card system 
suggested for production work.b

NVIDIA GeForce GTX TITAN
(6 GB, 2688 CUDA cores)

NVIDIA GeForce GTX 780
(3 GB, 2304 CUDA cores)

NVIDIA GeForce GTX 770
(2 GB, 1536 CUDA cores)

NVIDIA GeForce GTX 760
(2.0 GB, 1152 CUDA cores)

NVIDIA GeForce GTX 780M
(3 GB, 1536CUDA cores)

NVIDIA GeForce GTX 770M
(2 GB, 960 CUDA cores)

NVIDIA GeForce GTX 765M
(2 GB, 768 CUDA cores)

NVIDIA GeForce GTX 680
(4 GB, 1536 CUDA cores)
Copyright © Bunkspeed, Inc. 2002-2014 4
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NVIDIA GeForce GTX 670
(2 GB, 1344 CUDA cores)

NVIDIA GeForce GTX 660 Ti
(2 GB, 1344 CUDA cores)

NVIDIA GeForce GTX 660
(2 GB, 960 CUDA cores)

NVIDIA GeForce GTX 680MX
(2 GB, 1536 CUDA cores)

NVIDIA GeForce GTX 680M
(2 GB, 1344 CUDA cores)

NVIDIA GeForce GTX 675MX
(2 GB, 960 CUDA cores)

NVIDIA GeForce GTX 675M
(1.5 GB, 384 CUDA cores)

Graphic Cards certified. 
Multiple cards, 256+ CUDA 
cores, 2+ GB graphics memory, 
minimum spec. 
Dual or quad graphics card 
configuration highly 
recommended for pro level 
work. 3 GB or more suggested 
for production work.c

NVIDIA Quadro K6000
(12 GB, 2496 CUDA cores)

NVIDIA Quadro K5000
(4 GB, 1536 CUDA cores)

NVIDIA Quadro K4000
(3 GB, 768 CUDA cores)

NVIDIA Quadro 6000
(6 GB, 448 CUDA cores)

NVIDIA Quadro 5000
(2.5 GB, 352 CUDA cores)

NVIDIA Quadro 4000
(2 GB, 256 CUDA cores)

NVIDIA Quadro K5000M
(4 GB, 1344 CUDA cores)

NVIDIA Quadro K4000M
(4 GB, 960 CUDA cores)

NVIDIA Quadro K3000M
(2 GB, 576 CUDA cores)

NVIDIA Quadro K2000M
(2 GB, 384 CUDA cores)

NVIDIA Tesla K20X
(6 GB, 2688 CUDA cores)

NVIDIA Tesla K20
(5 GB, 2496 CUDA cores)

NVIDIA Tesla K10
(8 GB, 3072 CUDA cores)
Copyright © Bunkspeed, Inc. 2002-2014 5
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NVIDIA Tesla M2090
(6 GB, 512 CUDA cores)

NVIDIA Tesla M2075
(6 GB, 448 CUDA cores)

NVIDIA Tesla C2050
(3 GB, 448 CUDA cores)

NVIDIA Tesla C2070
(6 GB, 448 CUDA cores)

Graphics Driver (Certified) 320.xx (Windows 8 and 7, 64-bit)

Monitor 1280 x 1024 or higher

Licensing Node Locked or Floating License

Boost Internet (Pro only)

• Mandatory - All machines must have 
the same OS including the bitrate. We 
recommend all Windows 7 64bit.

• Mandatory - If the machines are 
Windows Vista, 7 or 8, UAC (User 
Account Control) must be turned off or 
to the lowest setting.

• Mandatory - Boost Service needs to 
be granted a firewall exception on port 
number 46001, or the firewall needs to 
be turned off.

• Mandatory - All machines must be on 
the same subnet mask.

• Minimum specs for each machine in 
the network are the same minimum 
specs to run Pro.

• In order to leverage GPU Boosting, 
the GPU's on all involved machines 
must be identical running identical 
drivers.

• If Hybrid mode is chosen for a 
Boosted rendering, it will best to 
determine whether most machines in 
the network will be of more use by 
supplying their CPU Power OR GPU 
power, not a mix of the two.

a. As you increase realtime resolution, performance decreases.
b. We recommend using the latest “Fermi” generation of nVidia GPU's, which out-

perform previous generations.
c. We recommend using the latest “Fermi” generation of nVidia GPU's, which out-

perform previous generations.
Copyright © Bunkspeed, Inc. 2002-2014 6
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INSTALL, LICENSE, AND RUN BUNKSPEED  
DRIVESUITE 

1. Download the Bunkspeed  DriveSuite file from Bunkspeed’s web site.

2. On your local computer, unzip the file and run it. Follow the instructions on 
the screen to complete the installation.

3. When you run Bunkspeed  DriveSuite for the first time, you will probably 
see the following screen first (see image below). In this License Landing 
Screen, click Licensing to display the Bunkspeed Licensing options.

4. In the Bunkspeed Licensing screen, select one of the following options:
– ACTIVATE: Enter the Activation ID you received from Bunkspeed, or 

click Use Floating License and enter the address of the license 
server on your network on the Internet (see images below)

– PURCHASE: Select this option to open a web browser to Bunkspeed’s 
web site, where you can buy a license and receive an Activation ID.

– Back: Return to the previous No License screen.
Copyright © Bunkspeed, Inc. 2002-2014 7
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5. After handling the licensing, the next step on first run is to select the 
location of the folder under which Bunkspeed  DriveSuite stores all your 
project assets, when prompted.

6. In subsequent runs, the Welcome Screen (see figure below) gives you 
following options.

RENDERING HARDWARE MODE
Different systems can produce different results with each render mode. You 
should try each mode before settling on the mode that works best for you:

– CPU Only: Select this option if you have anything other than a nVidia 
CUDA-enabled GPU with more than 1 GB VRAM.

– GPU Only: Select this option if you have a much better graphics card 
that your CPU. For a list of cards that work well with this software, see 
“System Requirements” on page 4.

– Hybrid: Select this option if you have a balanced system with a good 
nVidia card as well as a comparable CPU.

PROJECT TO OPEN
– New Project: Creates a new project that’s empty except for the 

default HDR environment image to provide lighting.
– Open Project: Displays a file loader so you can locate and open a 

native Bunkspeed  DriveSuite file (BIF format) in an arbitrary location.
– Recent Projects: Lets you open a project from a list of recently 

opened projects. On first run, this list will be empty, of course.
– Sample Projects: Use the Bunkspeed Phone project to do the 

“Bunkspeed Tutorial” on page 10.
Copyright © Bunkspeed, Inc. 2002-2014 8
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BUNKSPEED CONTENT FOLDER

When you install Bunkspeed DriveSuite, it asks you for a location to create a 
“Content” folder. The Content folder contains the following sub-folders in 
which you can store future assets for your projects:

• Cameras: Stores default cameras, as well as cameras that you have 
saved.

• Environments: Stores high dynamic range images.

• Palettes: Stores exported palette files.

• Images: Stores renderings and snapshots.

• Materials: Stores the materials in your Material Library. The contents 
update when you add a material to the Library.

• Models: Stores model files. By default, Bunkspeed  DriveSuite will look in 
this folder first when you import a model.

• Plates: Stores standard 2D images for use in backplates.

• Projects: Stores native project files (BIF format).

• Textures: Stores 2D textures for use in materials. 

HELP RESOURCES

The following instructional resources are available for Bunkspeed DriveSuite:

• Contents: Displays the Bunkspeed  DriveSuite User Guide you are 
reading now. You can learn the essentials of Bunkspeed  DriveSuite in 
less than one hour by doing the “Bunkspeed Tutorial” on page 10 in 
this User Guide. And you can quickly get details on any  DriveSuite -
related subject in this User Guide.

• About: Provides the version number and similar information for your copy 
of Bunkspeed DriveSuite.

• System Info: Summarizes how well Bunkspeed  DriveSuite will likely 
perform using your OS and hardware. Advises you of things that could be 
upgraded to improve performance.
Copyright © Bunkspeed, Inc. 2002-2014 9
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Chapter 2: Bunkspeed Tutorial

The tutorials in this chapter teach you the basics of Bunkspeed DriveSuite. 
Prepare to be rendered speechless (literally) in just 30 minutes! You can 
create typical Bunkspeed  DriveSuite projects in the following phases:

• Getting Started in Standard Mode:
– Launch!
– Import a 3D Model (a.k.a. “object” or “mesh”) to serve as a 3D 

subject in your Bunkspeed  DriveSuite project.
– Use the Camera.
– Assign and Edit Materials for your models.
– Import an HDR Environment Image to provide lighting for your 

models.
– Import a Backplate Image to provide a high quality background.
– Output the Images in various formats.

• Using Easy Mode

GETTING STARTED IN STANDARD MODE

Every Bunkspeed product can be configured (in the Options Panel) to start in 
either Standard Mode or Easy Mode. Shot defaults to Easy Mode. Pro Suite, 
Zoom, and Drive Suite default to Standard Mode.

’The following instructions will get you started in Standard Mode:

Launch!

1. To run Bunkspeed DriveSuite, select Bunkspeed  DriveSuite in the Start 
Menu. The Welcome Window appears – unless this is the first time you 
have run this installation, in which case refer to Install, License, and Run 
Bunkspeed DriveSuite .

2. In the Welcome Window, select New Project to load an empty scene with 
the default environment image.

Import a 3D Model

3. Next, import a model into your new project: Select Project > Import 
Model from the Main Menu to display a file loader you can use to open a 
model in the Bunkspeed Content \ Models folder. 
– Accept the default options in the Import Model dialog box.
Copyright © Bunkspeed, Inc. 2002-2014 10
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– Depending on the size of the file and your computer’s hardware, it 
may take a few seconds for the model to fully load.

– Once the model loads into the open scene, Bunkspeed  DriveSuite 
will show your project in real-time.

For details on models, see "Chapter 4: Working with 3D Models” on 
page 66.

Use the Camera
You can move the current camera relative to the look-at point. You can of 
course change the look-at point too. (The look-at point is the point in 3D 
space where the camera focuses, rotates around, and zooms towards.)

4. To move the camera, HOLD the ALT-KEY and use the mouse as follows:
– Rotate: LEFT-CLICK-HOLD inside the Viewport and DRAG the 

MOUSE to orbit the camera around the focal point.
– Pan: MIDDLE-CLICK-HOLD inside the Viewport and DRAG the 

MOUSE to move the camera and focal point together.
– Zoom: RIGHT-CLICK-HOLD inside the Viewport and DRAG the 

MOUSE to zoom the camera in / out, relative to the focal point.
– Perspective: ROTATE the MOUSE WHEEL to dolly and change the 

focal length of the virtual lens.
– Look-At: Or hold both the CONTROL and ALT-KEYS, and RIGHT-

CLICK on a new look-at point in the 3D Viewport.

For details on cameras, see “The Camera” on page 57.

Assign and Edit Materials
In Bunkspeed DriveSuite, a “material” is a scientifically accurate simulation of 
a substance such as polished aluminum, glossy paint, glass, emerald, wood, 
rubber, etc. By mapping materials on models, the models assume an uncanny 
realism.

Each “type” of material in Bunkspeed  DriveSuite is defined by a unique set of 
parameters, including up to four textures (color, specular, alpha, bump). 
Different materials of the same type have the same parameters with different 
values. Bunkspeed  DriveSuite comes with a variety of materials. You can 
create new materials by modifying the parameters of existing materials, and 
by importing materials created by others. For details on materials, see 
"Chapter 5: Working with Materials” on page 82.

Here’s how you map a material onto a part in a model:

5.

Library Tab

In the Palette, select the Library Tab to activate Library Mode.

6. To display the Material Library, select Materials in the drop-down menu 
near the top of the Library Tab. The Materials Library contains all the 
materials (in BMF format that can be shared and emailed) in the 
Bunkspeed Content \ Materials folder, by default. Notes:
– You can obtain materials from the Bunkspeed web library. For 

instructions, see “Web Libraries” on page 55.
– Materials can also be created via the right-click menu in the material 

tab of the Palette.
Copyright © Bunkspeed, Inc. 2002-2014 11
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7. DRAG-AND-DROP any material from the Materials Library to the target 
part in the model in the 3D Viewport. This action accomplishes two things:
– The material is mapped to the target part.
– The material is added to the current project, and will be packaged and 

saved with the current project – making the material independent of 
your Material Library.

Do not confuse the Materials Library in the Library Tab with the Materials Tab:

• The Materials Library is accessible via the Library Tab of the Palette. The 
Materials Library contains all the material files in the Bunkspeed Content \ 
Materials folder, by default – regardless of whether or not these materials 
are used in the open project.
– The materials in the Material Library are independent of specific 

projects, making the entire Material Library available to all projects.
– You cannot directly edit a material in the Material Library. But you can 

bring a material from the Material Library into the open project, and 
then edit the material with the parameters in the Material Tab, and 
save the modified material as a new material in the Material Library.

–  DriveSuite saves materials in BMF format in the Bunkspeed Content 
\ Materials folder, by default. You can copy, share, and even email 
BMF files to other  DriveSuite users.

• The Materials Tab of the Palette contains only the materials that have 
been added to the open project.
– Note: In the Materials Tab, LEFT-CLICK any material to display its 

parameters. You can optionally edit these parameters to modify the 
material. Your edits will effect instances of the material on parts in the 
open project, but will not affect the Material Library.

Import an HDR Environment Image
High dynamic range images (HDR) can contain a far greater contrast range 
and color depth than regular 2D images. HDR images accomplish this by 
using special formats, such as HDR and EXR, that describe RGB colors with 
32-bits per channel of data. That’s a lot more color and luminance information 
than standard 2D images using 8-bits per channel.

Bunkspeed  DriveSuite lets you load an HDR image onto an environmental 
sphere that contains your entire scene. The HDR image will then radiate light 
into your scene from all directions, according to the RGB values of individual 
pixels in the HDR image. Here’s how:

8. To display the Environments Library, LEFT-CLICK the Library Tab in the 
Palette, and then select Environments in the drop-down menu therein. 
The Environments Library contains all the HDR images in the Bunkspeed 
Content \ Environments folder, by default.

9. In the Environments Library, DRAG-AND-DROP any HDR image into the 
3D Viewport. This action applies the HDR image to the environment 
sphere containing the open project, causing the HDR image to provide 
the light in your scene.
– Alternative: Double-click the environment icon in the Environment 

Library to load it into the environment of the open scene.
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– Alternative: New HDR environment images can also be loaded via 
the right-click menu in the Scene tab of the Palette.

10. You can tune an HDR image in Scenes Mode, as follows:
– To activate Scenes Mode, LEFT-CLICK the Scenes Tab tab in the 

Palette (see the figure to the left). All environments that have been 
loaded into the open project are listed in the Scenes Tab of the 
Palette.

– In the Scenes Tab, LEFT-CLICK the target environment image in the 
Environments Tree near the top, and adjust the Brightness 
parameter to change the total amount of light the environment image 
radiates into your scene.

– Adjust the Gamma parameter to indirectly change the contrast of the 
environment image.

– Experiment with changing other parameters in the Scenes Tab.

• Here’s another way to apply a different environment image to the open 
scene:
i. Activate the Scenes Tab in the Palette. 
ii. In the Scenes Tab, double-click the icon of the environment you wish 

to load into the open scene.

For details on environments, see “Working with Scenes”.

Import a Backplate Image
A backplate is a standard 2D image that provides a background for your 
scene, without affecting the lighting in the scene. By design, backplates do 
not emit light into the scene, and do not receive shadows. Also, backplates 
always remain in the center of the 3D Viewport, orthogonal to the camera, 
regardless of where you move the camera.

You can use a variety of 2D image formats, such as JPEG, as backplate 
images. 

11. To display the Plates Library, LEFT-CLICK the Library Tab in the Palette, 
and select Plates in the drop-down menu. The Plates Library contains the 
backplate images in the Bunkspeed Content \ Plates folder, by default.

12. From the Plates Library, DRAG-AND-DROP any image therein into the 
3D Viewport – placing the image in the background of your project. After 
loading a backplate image into the open project, the image will be listed in 
the Scenes Tab of the Palette.
– Alternative: New backplates can also be loaded via the right-click 

menu in the Scene tab of the Palette.

For details on backplates, see "Chapter 6: Working with Scenes” on 
page 88.

Output the Images
This section introduces you to outputting images from Bunkspeed DriveSuite. 
For details, see "Chapter 8: Saving and Outputting” on page 101.
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13. Adjust your camera to position it and the model in the 3D Viewport, so as 
to position them exactly as you want the output image of the scene.

QUICK SNAPSHOT
To output a quick snapshot of the scene on your screen, do the following:

14. In the Main Toolbar, LEFT-CLICK the Render button to reveal the types 
of rendering: Snapshot, Render, Animation, Turntable, and Sun Study.

15. In the drop-down icons (or dialog box), select the Snapshot icon to take a 
quick snapshot (i.e. a customized screen shot without raytracing) of the 
open scene from the perspective of the current camera. 

16. Set the Snapshot options, and then CLICK Take Snapshot. Bunkspeed 
DriveSuite saves the screenshot in the Images Library (the Bunkspeed 
Content \ Images folder by default).

HIGH QUALITY RENDERING
To output a high quality rendering of your scene, do the following:

17. In the Toolbar, LEFT-CLICK the Render button to reveal the icons for the 
various types of rendering.

18. In the drop-down icons, select the Render icon to display the Render 
dialog. 

19. In the Render dialog, there are a few different types of rendering to 
choose from. The process for each type of high quality rendering is 
explained in detail in “Outputting Images” on page 101.

The rendering may take a few minutes, depending on your hardware. 
Bunkspeed  DriveSuite saves the rendering in the Images Library (the 
Bunkspeed Content \ Images folder by default).

USING EASY MODE

Every Bunkspeed product can be configured (in the Options Panel) to start in 
Easy Mode. Shot defaults to this mode. Pro Suite and Drive Suite default to 
Standard Mode.

In Easy Mode, the Floating Toolbar hides automatically, and appears when 
you mouse-over it. Also, a wizard appears at the bottom of the UI, with the 
following buttons:

1. Import: Click to import a model via a File Loader, or an drag-drop a CAD 
file into the application window.

2. Paint: Displays the Material Library, from which you can drag-and-drop 
materials onto imported models and their parts. To edit a material that 
you’ve applied to a model or part:
– double-click on a representative part to display the Material Tab;
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– or right-click on part, and select Material Properties in the context-
sensitive menu, to display the Material Tab.

3. Scenes: Opens the Scenes library, from which you can drag-and-drop an 
HDR environment image into your scene.

4. Camera: Opens the Camera Panel, which provides common camera 
controls like Brightness, Perspective, and filters like Sepia tone.

5. Render: 
– Left-click to start rendering in your current mode (i.e. Preview or 

Accurate).
– Right-click to bring up the Render dialog, where you can choose 

render settings.
– Select “More Options” to open the full Render Panel.
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USING PRESENTATION MODE

Presentation Mode is optimized for the real-time presentations of existing 
scenes, not for editing scenes.

In Presentation Mode, the Viweport fills the screen, much like Full Screen 
Mode. The floating Presentation Toolbar, designed for controlling the 
presentation of the loaded scene, is the only UI available.

Entering and Exiting Presentation Mode
You can enter Presentation Mode any time after creating a new scene, or 
loading an existing scene. To do so, select Enter Presentation Mode in the 
View Menu, or use the Ctrl-M hotkey. To exit Presentation Mode, use the Ctrl-
M hotkey again, or press the Esc-key.

Using the Presentation Toolbar
The purpose of the Presentation Toolbar is to give you extensive control of 
presenting real-time scenes.

The Presentation Toolbar floats on top the existing scene, and fades out when 
you’re not using it. You can toggle the visibility of the Presentation Toolbar by 
pressing the Space-key.

CUSTOMIZING THE PRESENTATION TOOLBAR
You can customize the Presentation Toolbar as follows:

• Drag-and-drop controls within the Toolbar changes their order. Dropping a 
control outside of the Toolbar hides it.

• Toggle the visibility of each control in the Presentation Toolbar via the 
Customize Toolbar drop-down menu on the lower right of the Toolbar 
(see the figure to the left).
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USING THE CONTROLS
The Presentation Toolbar contains the following controls in the default order:

• Render Mode: Same control as in the Main Toolbar.

• Configurations: Lets you select a specific Configuration, and switch 
consecutively between existing Configurations (previous, next). No 
authoring (e.g. creating new Configurations) is supported here.

• Model Sets: Lets you select a specific Model Set, and switch 
consecutively between existing Model Sets (previous, next). No authoring 
(e.g. creating new Model Sets) is supported here.

• Turntables: Lets you take the following actions on the selected model or 
models in the combo box:
– Create/Remove
– Play/Pause
– Faster/Slower
– Reverse Direction
– Reset

• Selection Mode: Same control as in the Main Toolbar.

• Object Manipulator: Same control as in the Main Toolbar.

• Camera Tools: Same control as in the Main Toolbar.

• Cameras: Lets you select a specific Camera and switch consecutively 
between existing Cameras (previous, next). No authoring (e.g. creating 
new Cameras) is supported here.

• Animations:  Lets you take the following actions on the current selections 
in the combo box:
– Play/Pause
– Faster/Slower
– Previous/Next Frame.
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Chapter 3: Overview of the User Interface

The User Interface of Bunkspeed  DriveSuite contains the following elements:

• Main Menu 

• Viewports

• Toolbars 

• Palette

• Context Sensitive Menu

• The Camera

• Animation Timeline and Controls

Main Menu Main Toolbar Viewports Palette

Animation Timeline and Controls

Camera Toolbar
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When Drive initially opens, you can choose to use the CPU Only, GPU Only, 
or Hybrid (a combination of both) to do raytracing.

After selecting the raytracer that best utilizes your particular hardware, you 
can then select New Project to start a blank project, or Open Project to 
continue work on an existing project. You can also choose from the list of 
Recent Projects and Sample Projects in most cases.

When your project has finished loading, you can modify the UI of Drive as 
follows:

• To change the width of the Palette, drag its border with the mouse.

• To break the entire Palette away from its dock, Click-Hold-Drag any tab in 
the Palette. You can drag a free-floating palette anywhere on your screen.

• To dock a free-floating Palette, drag it near one of the edges of the Drive 
Window. Anchor arrows will appear on the left or right sides. Release the 
Palette on top the arrow on the desired side.

• To hide the Toolbar or HUD when it’s not in use, Click the pin at the upper 
right edge. To reveal a hidden Toolbar or HUD, just mouse-over the area it 
normally resides. Click the pin again to keep it visible.

MAIN MENU

The Main Menu in Bunkspeed Drive includes the following pull-down menus:

• File Menu

• Edit Menu

• View Menu

• Project Menu

• Tools Menu

• Help Menu

• Progress Bar
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File Menu
The File Menu provides the following options:

• New Project: Creates a new Bunkspeed Drive project. New projects are 
empty except for the default HDR environment image to provide lighting.

• Open Project: Lets you load an existing project from your hard drive or 
network.

• Recent Projects: Lets you select and open a project from a list of 
recently opened projects.

• Open Image: Lets you locate and open a 2D image in the Image 
Viewport.

• Open Palette: Lets you locate and open a material palette.

• Import: Lets you import a 3D model into the open Bunkspeed Drive 
project. For details, see Importing Models.

• Export: Lets you export the open project to any of the following formats:
– Autodesk FBX
– OBJ

• Save Project: Saves your current Bunkspeed Drive project:
– in native BIF format, overwriting the same location and filename as 

the original.
– as a Palette file. You can generate read-only Presets consisting of 

any combination of materials, scene elements (backplates, HDR 
images, lights), cameras, and render settings – and then save each 
Preset combination as a Palette file. Non-expert users can then open 
these Palette files, which default to Easy Mode, and view (but not 
change) materials, cameras, scenes, render settings. Downstream 
users can then load a Palette file, import their own geometry into it, 
and apply the read-only materials in various ways -- i.e. to play with 
various uses of a company-approved project. Pre-Defined 
Bunskpeed Palettes are a good way to distribute content to 
designers, while still controlling materials.

• Save Project As: Saves your current Bunkspeed  DriveSuite project file 
in BIF format, using the arbitrary file name and location that you specify.

• Close: Closes the current project and leaves Bunkspeed  DriveSuite 
running.

• Exit: Exits Bunkspeed DriveSuite.
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Edit Menu
The Edit Menu provides the following standard options:

• Undo

• Redo

• Cut

• Copy

• Paste

• Delete

• Select All

• Deselect All

• Find

View Menu
The View Menu provides the following options:

• Model Mode: Activates Model (Object) Mode and displays the contents 
of the Model / Objects Tab in the Palette.

• Material Mode: Activates Material Mode and displays the Material Tab in 
the Palette.

• Scene Mode: Activates Scene Mode and displays the contents of the 
Scenes Tab in the Palette.

• Camera Mode: Activates Camera Mode and displays the contents of the 
Cameras Tab in the Palette.

• Library Mode: Activates Library Mode and displays the contents of the 
Library Tab in the Palette.

• Easy Mode: Activates a simplified user interface optimized for novice 
users. For details, see “Using Easy Mode” on page 14.

• Show HUD: Toggles visibility of the heads-up display, which shows some 
or all of the following data (depending on the current mode):

– Total Frame Count: This number grows until you stop the session.
– Progress: Provides an approximation of the rendering progress.
– Frames per Second: tells you the average framerate (passes), 

which are iterations on the final image that progressively get more 
refined and less noisy.
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– Resolution: the resolution (i.e. in pixels, width by height) of the 3D 
Viewport as well as output Snapshots.

– Polygon Count: number of actively used polygons in the project.
– Focal Length: the focal length (in millimeters) of the virtual lens for 

the camera used for the rendering.
– GPU Only, CPU Only, or Hybrid indicates the current rendering 

hardware.
– Status Icons: Glowing buttons in the top right of the HUD (left to right 

in figure below):

» Super Sampling
» Camera Locked
» Animation Recording
» Physics Enabled

• Build All Thumbnails: Generates thumbnail images of materials, 
models, and similar elements in the Palette.

• Pause Rendering: Stops raytracing in the Viewport. Unpausing resumes 
raytracing in the Viewport.

• Enable Raytracer: Toggles real-time raytracing in the 3D Viewport.

• Multi-Viewports: Lets you show one, two, or four Viewports 
simultaneously, with each Viewport referencing a potentially separate 
camera, model set, and environment. This feature is useful for 
presentations and setting up animations.

• Show Camera Panel: Toggles the Camera Toolbar / Panel.

• Show Palette: Toggles the Palette.

• Show Queue: Displays the Queue Panel.

• Show Timeline: Shows the Animation Timeline and Controls.

• Enter Full Screen: (F11) Maximizes the Bunkspeed  DriveSuite window 
and hides the Main Menu, borders, and tabs. Press F11 to return to the 
windowed mode.
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Project Menu
The Project Menu provides the following options:

MODEL

• Show Everything: Reveals all models and parts that may have  been 
hidden.

• Select Parts to Split: Activates the Parts Selector, so you can select the 
parts you want to split.

• Import Model: Lets you locate and open a 3D model to import into the 
open Bunkspeed  DriveSuite project. For details, see Importing Models.

• Create Model: Creates the standard geometric shape (e.g. sphere, cube, 
cylinder, etc) that you choose from the drop-down list.

MATERIAL

• New Material: Creates a new material in the open project, and opens the 
Material Tab in the Palette so you can customize the new material.

ENVIRONMENT

• New HDR Environment: Brings up a file loader so you can locate and 
open a high dynamic range image to provide environmental lighting in 
your scene.

• New Sun and Sky Environment: Creates a new Sky Study Environment, 
which simulates sunlight at a specific place and time. For details, see 
Create a New Sun and Sky Environment.

• Decrease Brightness: Decreases the brightness of the loaded HDR 
environment image.

• Increase Brightness: Increases the brightness of the loaded HDR 
environment image.

BACKPLATE

• New Backplate: Lets you locate and open a standard 2D image for the 
backplate behind your scene.

LIGHTS 

• New Light: Creates a new light in the open scene. For details, see 
“Create, Move, and Edit Custom Lights” on page 92.
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CAMERA

• New Camera: Creates a new camera at the default position, and 
switches the 3D Viewport to show the view from the new camera.

• Next: Switches the view in the 3D Viewport to the next camera in the list 
of existing cameras.

• Previous: Switches the view in the 3D Viewport to the previous camera in 
the list of existing cameras.

• Reset: Repositions the current camera to the world origin.

• Lock: Prevents the current camera from being moved.

• Save to File: Saves the current camera to a file, so the camera can be 
shared with other projects and users.

CONFIGURATIONS
You can manage configurations with the following controls in the Project 
Menu, or the Configuration Tools in the Toolbar.

• New Configuration: Creates a new Configuration using the current 
scene.

• Next: Changes the scene to the next Configuration in the Configuration 
List.

• Previous: Changes the scene to the previous Configuration in the 
Configuration List.

• Reset: Clears all Configurations

PROJECT

• New Model Set: Creates a new model set, which can contain multiple 
models in the same scene.

• Next: Displays the next Model Set in the list.

• Previous: Displays the previous Model Set in the list.

Tools Menu
The Tools Menu provides the following options:

• Snapshot: Takes a quick snapshot of your current Bunkspeed  DriveSuite 
scene, exactly as it appears in the 3D Viewport, and saves the screenshot 
in the Images Library.

• Render: Starts rendering your scene at the resolution specified in the 
Options Dialog. When completed, the rendering will be saved in the 
Images Library.

• Unify all Identical: 
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– ...Materials: Eliminates duplicate materials in your project.
– ...Textures: Eliminates duplicate textures in your project.

• Convert HyperShot Material Library: Causes Bunkspeed  DriveSuite to 
convert materials from earlier versions of Bunkspeed Shot (formerly 
called HyperShot) to the latest version of Bunkspeed  DriveSuite material 
files, and then places the converted materials in the default Material 
Library. Doing this can take time (up to 30 minutes), and is relevant only 
to those who used HyperShot to create custom materials that they have 
need for in Bunkspeed  DriveSuite.

• Deactivate License: If you wish to switch licenses (e.g. from a node-
locked license to a floating license), or transfer a license from one 
machine to another, use this option to deactivate your old license first. 
Then exit and restart DriveSuite. When the Licensing Setup screen 
appears, select the desired licensing option.)

• Login to Bunkspeed / Logout: Displays the login screen, so you can log 
into a remote Bunkspeed library – unless you’re already logged in, in 
which case you’d see the Logout option. For details, see Web Libraries.

• Options: Displays the Options Dialog described in detail, next.

OPTIONS DIALOG
The Options Dialog can be displayed by selecting Options from the Tools 
Menu, or pressing Ctrl-K. The Options Dialog includes the General, 3D 
Viewport, and User Interface Tabs. For details, see the sub-sections below.

General Tab

• Default Project: Determines the path to the project file that Bunkspeed  
DriveSuite opens by default when you fire it up. The provided Default 
Project.bif is empty except for a basic HDR image in the environment to 
provide lighting.
– To change the default project to the open project, LEFT-CLICK the 

Use Current Project as Default button.

• Library Paths: To change the folders containing any library, LEFT-CLICK 
the Browse button to the right of the target library, and navigate to the new 
folder for that library.
– Environments: Path to the folder containing the HDR images in the 

Environments Library.
– Materials: Path to the folder containing the materials in the Materials 

Library.
– Images: Path to the folder containing saved screenshots and 

renderings.
– Models: Path to the folder containing the models in the Model 

Library.
– Plates: Path to the folder containing the images in the Plates Library.
– Projects: Path to the folder containing the Bunkspeed  DriveSuite 

projects in the Projects Library.
– Textures: Path to the folder containing the images in the Textures 

Library.
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– Cameras: Path to the folder containing the cameras in the Cameras 
Library.

• Reset All Settings: Restores all options to their factory defaults.

3D Viewport Tab

• Realtime Options:
– Auto Pause: If enabled, Bunkspeed  DriveSuite pauses realtime 

raytracing when the application loses focus. When it regains focus, 
then the raytrace picks up from where it left off.

– Image Filtering: Image filtering is a new technique which reduces 
the noise of pixels in the rendering. It turns on a noise reduction 
technique for the first 50 passes of calculation, and then turns it off. At 
100 passes an actual image filter is then applied to completely 
remove noise. Enabling this option slows down the calculation rate of 
each pass, but still speeds up the appearance of a complete image!

– Maximum Resolution: The resolution (i.e. in pixels, width by height) 
of the 3D Viewport as well as output Snapshots.

• Fast Rendering Mode Options: The following options apply only when 
Fast Rendering Mode is enabled:
– Reflections and Ground Shadows Only: If enabled, reflections and 

ground shadows will be rendered. If disabled, they won’t be rendered.
– Accelerate Interactivity: When enabled, shadows turn off while you 

click-hold the mouse during real-time editing, so as to speed up 
responsiveness. Shadows reappear when you release the mouse. 
When disabled, shadows stay on during editing.

– Screen Space Shadows: 

• Display Options:
– World Axis: Toggles visibility of the world XYZ-axes. (This option is 

available only when raytracing is turned off.)
– Model Bounding Boxes: Toggles visibility of bounding boxes around 

models. (Available only when raytracing is turned off.)
– Parts Bounding Boxes: Toggles visibility of bounding boxes around 

parts in models. (Available only when raytracing is turned off.)
– Show Selection Outline: Toggles visibility of the highlight that 

appears around active selections. The highlight is useful for showing 
visually what is currently selected.

– Show Camera Icons: Toggles icons showing the locations of existing 
cameras in the scene.

User Interface Tab

• Interface Options:
– Enable Tooltips: Toggles visibility of short instructions which appear 

when you mouse over a button or control.
– Undo Camera Movements: If enabled, the Undo command undoes 

camera movements along with your other edits. If disabled, 
everything but cameras are undone.

– Walking Camera: Enables / disables the Walking Camera.
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– Automatically Update Thumbnails: If enabled, Bunkspeed  
DriveSuite updates all the thumbnails that appear everywhere in the 
Palette.

– Automatically Play Movies: If enabled, this option automatically 
plays movies when the “create movie” check box is checked when 
you render an animation. It will open and play the animation in 
whichever media player is associated with the extension that you 
output the movie at.

– Highlight Current Multi-Viewport: Enable to highlight the active 
Viewport in a multiple Viewport layout.

– Start in Easy Mode: If enabled, the application will start in Easy 
Mode on subsequent runs. If disabled, the app will start in Regular 
Mode.

– Material Assignment Preview: If enabled (the default), you will see 
a preview of the selected material applied to objects as you drag it 
over them. If disabled, you will not see how the selected material 
looks on an object until after you have finished assigning the material 
to a specific object.

• Timeline Options:
– Default Keyframe Tangent Rule In: Enable to set the default style of 

keyframes, upon their creation.
– Default Keyframe Tangent Rule Out: Same as above.

• Turntable Presentation Options:
– Auto-Size Turntable: When enabled, the size of the turntable is 

automatically determined by the size of the model. When disabled, 
the size of the turntable is set manually by Default Turntable Size 
(below).

– Default Turntable Size (m): When Auto-Size Turntable (above) is 
disabled, you can set the size of turntables (in meters) by entering a 
value or using the slider.

• Space Mouse Options:
– Navigation Mode: Choose between Camera / VR (inverted) mode or 

World / CAD mode (the default).
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Import Tab

• Auto-Size Options: Lets you set the rules for the size objects should be 
scaled to when they are “auto-sized” upon import.
– Minimum Size Limit: Sets the smallest that a part should be if it 

initially imports far too large.
– Maximum Size Limit: Sets the largest that a part should be it initially 

imports far too small.
– Scale Using Powers-Of-Ten: Applies a power of ten multiplier to 

either increase or decrease the size of the original model when it is 
auto-sized. 

• Auto-Paint Options: When enabled, Autopaint builds an association 
between the names you give parts/materials/layers in your CAD package, 
and the names of Bunkspeed Drive Suite materials you assign to those 
parts after import. Based on your paint/naming pattern, Drive Suite learns 
how to Autopaint a model upon import. (Example: Suppose in CAD you 
always name a tire layer “Tires,” and in Bunkspeed Drive Suite you 
always paint the part called “Tires” with the Black Rubber material. As a 
result, every time you import a model that has a part called “Tires,” Drive 
Suite will automatically assign the Black Rubber material to that part. This 
feature essentially lets you pre-paint your model in the CAD package, so 
you don't have to assign materials once that file is imported.)
– Enable Auto-Paint by Default: Activates the auto-paint feature each 

time the program is run.
– Enable Auto-Paint Data Storage: Activates a persistent list of the 

associations you make during usage.
– Maximum Auto-Paint Storage: Lets you determine how big the Data 

Storage list can get.
– Reset Auto-Paint Data: Clears your Data Storage list and lets you 

start over.

Export Tab

• Include: 
– All Available Cameras: If enabled, the application exports the views 

from all the still cameras in your scene to FBX format. Enabled by 
default.

Raster Tab
The settings below do not have any effect on raytraced output or realtime 
raytracing. These options affect only realtime Preview rendering mode:

• Quality Options:
– Anti-Aliasing Level controls the process of softening the unnaturally 

precise or stepped edges (sometimes known as ‘the jaggies’) that are 
created when a computer-generated object is placed against a 
contrasting background. This softening process is accomplished by 
using pixels of intermediate shades as a buffer between the object 
and its background. The higher the value of Anti-Aliasing Level, the 
better the step removal, but the more impact the performance. The 
available settings will vary based on your video card.
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– Maximum Texture Resolution: Lets you select the maximum texture 
resolution. The default is 4096x4096 pixels. The following options are 
available: 
» 2048x2048 (DirectX8 maximum)
» 4096x4096 (DirectX9 maximum)
» 8192x8192 (DirectX10 maximum)
» 16384x16384 (DirectX11 maximum)

– Shadow Quality determines the smoothness of the ground shadow 
and self-shadows.

– Shadow Resolution determines the pixel dimensions for the map 
created for the shadow projections.

– Environment Resolution determines the pixel dimensions used to 
clamp the HDR environment image.

– Gloss Resolution determines the pixel dimensions that the reflection 
map is calculated at, so as to determine the material gloss levels.

– Limit Rough Reflection Maps: When enabled, the roughness of 
materials is classified into four gloss levels using a faster but less 
accurate technique. When disabled, the actual roughness of 
materials is calculated with a slower but more accurate process.

• Supersampling Accumulation Options: Accumulation is a 
supersampling process that anti-aliases the scene, conveys accurate 
environment-based lighting and shadows, and adds subtle depth-of-field 
to the scene. (Note: Enable Depth-of-Field in the Cameras Palette before 
using the Accumulation feature.)
– Enable Automatic Supersampling: When enabled, accumulation 

starts in the loaded scene when you press F10, and continues to 
improve the scene over time. When you do anything in the Viewport, 
such as move the camera, accumulation pauses.

– Auto Supersample Delay Time: Sets the time before accumulation 
begins, after which you pause real-time work.

• Performance Options:
– Enable Performance Mode: Activates a drawing mode wherein all 

shaders are simplified significantly, so as to dramatically increase the 
speed of realtime editing. It is useful for models that are very large or 
have lots of textures – and for ensuring animations play back 
consistently at 30 FPS. Even if this mode is enabled, the final image 
will still be rendered with the original shaders.

Boost  Tab

• Boost Options:
– Start / Stop Boost: Starts or stops Boost.

• PowerBoost Options: Use these options to set up your connection to a 
remote PowerBoost server, if you have a PowerBoost license. 
PowerBoost enables you to upload/download scenes to the Bunkspeed 
Cloud for rendering by powerful computers – freeing your local PC to do 
other work.
– PowerBoost Server: The name of the cloud server on which a 

PowerBoost Host is running.
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– PowerBoost User Name: Your user name for logging into the 
PowerBoost server to upload or download your scenes. The default is 
the user name for your Windows login.

– PowerBoost Port: Retain the default value of 8050, unless a 
Bunkspeed representative provides you with a different value.

Queue Tab

• Queue Client Options:
– Automatically open Queue client when a job is sent to the 

Queue: When enabled, your local Queue client opens whenever you 
send a job to the Queue for rendering.

• Queue Server Options:
– Queue server is currently: (read-only) Shows the current state of 

the Queue server (i.e. Stopped, Running, etc).

• Local Queue:
– Queue Port: Sets the port number for the Queue. The default of 8050 

is used because its usually available.
– Number of days to save files: Sets the number of days the Queue 

keeps render jobs before deleting them.
– Minimum hard drive free space (percentage): The amount of free 

space you need on your local hard drive in order for Queue to work.
– Render timeout (seconds): The time after which the Queue stops 

the transfer of the current job.
– Output Directory: The folder where the results of Queue renderings 

are saved.
– Start / Stop Queue: Click to start or stop the Queue server.

Help Menu
The Help Menu provides the following options:

• Contents (F1): Opens the Bunkspeed  DriveSuite User Guide you are 
reading.

• Hotkeys: Pops up a dialog listing the current hotkeys.

• About: Displays the version number of your copy of DriveSuite.

• Check for Updates: Checks online and notifies you whether or not an 
updated version of the application is available.

• Show Release Notes: Displays Release Notes for the current build.

• System Info: Provides an estimate of performance of Bunkspeed 
software your PC hardware, and suggests upgrades when needed.
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Progress Bar
The Progress Bar appears on the far right of the Main Menu, above the 
Palette, whenever  DriveSuite is doing tasks that take substantial time to 
complete.
Copyright © Bunkspeed, Inc. 2002-2014 31



Bunkspeed  Drive Suite User Guide Overview of the User Interface Viewports
VIEWPORTS

A Viewport dominates most of the area in the Bunkspeed  DriveSuite window. 
Bunkspeed  DriveSuite provides you with a 3D Viewport, plus additional tabs 
that appear when you open images in the Image Viewport, as explained 
below.

3D Viewport
The 3D Viewport shows the open project with the currently selected camera. 
When you move the camera around the scene, or change any content, the 3D 
Viewport updates in real-time.

Image Viewport
The Image Viewport displays the images in the Image Library. Since 
screenshots and renders are saved to the Images Library by default, the 
Image Viewport is a convenient way to look over your output images.

Rendering Viewport
The Rendering Viewport displays the currently rendering image, when 
applicable.

Login System
Bunkspeed  DriveSuite provides a convenient means for you to download 
content for use in your projects. By copying shared content from Bunkspeed's 
servers to your local hard drive, you can quickly build a vast local library of 
materials, HDR environment images, models, backplate images, and more! 
For details on usage, see “Web Libraries” on page 55.
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TOOLBARS

The Main Toolbar provides selectors for most tools other than the camera. 
The Camera Toolbar / Panel provides controls for the current camera.

Main Toolbar
The Toolbar appears near the top of the 3D Viewport, by default. The Toolbar 
provides you with shortcuts to some of all of the following functionality 
depending on which version of software you have.

CONFIGURATION TOOLS
As you edit a scene, the cumulative cause-and-effect result of your actions is 
of course what you see evolving on your screen. Your edits are part of the 
configuration you were in when you made them. When you first create a new 
project, the base configuration is automatically selected, so all your edits are 
part of the base configuration.

When you create a new configuration, or select any existing configuration 
other than the base, then you are creating a new branch to store your 
subsequent edits. For example, if you create a new configuration called 
“Config1,” and then change the dominant color of your model, the change is 
applied in Config1 only. While you remain in Config1, the change in color is 
clearly visible. But if you then switch back to the base configuration, then you 
will see your model in its previous color prior to creating Config1. In short, 
actions you take while in one configuration do not affect the edit history of 
other configurations – with the exception of the base configuration itself. Edits 
you make while in the base configuration affect all other configurations.

The primary use of creating new configurations is to provide slightly different 
versions of a base scene. For example, while in the base configuration, you 
could create and finish a scene containing a yellow car model lit by an HDR 
image taken in a specific dealer showroom. Then you could create a new 
configuration called “Red Car,” and paint the car red. Then create a “Black 
Car” configuration and paint the car black. You could then switch between 
yellow, red, and black cars simply by switching configurations.

The following Configuration Tools shows you which configuration you’re 
currently working in, and provides quick means to switch configurations:

• Configuration List (showing “Configuration 1"): Shows the currently 
active configuration. Click to see a list of existing configurations; select a 
configuration from the list to switch to it.

• (+) Creates a new configuration. Thereafter, all subsequent editing in the 
3D Viewport applies to this new configuration only, unless you switch to a 
different configuration.
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• <- Edit -> Lets you rename or duplicate the active configuration. The left 
and right arrows cycle through existing configurations.

• (double arrow button) Reverts the Configuration list to the base 
configuration.

Context-Sensitive Configuration Menu
Almost everything in Drive can be put into Configurations. Here’s what you 
can do with them in the context-sensitive menu:

• In the Materials Tab of the Palette, if you right-click a material that’s used 
in a model. Then in the context-sensitive menu:
– select Set (Material) in Configuration > Set in New Configuration 

to create a new Configuration and add the selected material to it;
– or select an existing custom Configuration from the list.

• You can now lock a Configuration in the floating Palette / Toolbar. When 
used for HDR images and backplates, the word “Material” doesn’t appear.

• Can now click Edit in the floating Toolbar, and then Duplicate an existing 
Configuration. You are then free to experiment with that configuration 
while preserving the original.

RENDER SELECTION
The Render Selection button in the Main Toolbar (see figure to left) lets you 
select from the following real-time rendering modes:

• Preview: A realtime approximation of raytraced lighting.

• Accurate: Top quality rendering using new iRay and Stellar raytracing 
technology. Takes longer of course.

• Blended: When in Accurate rendering mode, enabling Blended causes 
the scene to automatically switch to Preview Mode whenever you do 
anything – such as moving the camera, moving the model, playing an 
animation, dragging a material, and even just clicking the mouse in the 
Viewport. As soon as you stop clicking or moving the mouse, the scene 
starts to accumulate raytraced lighting again.

TURNTABLE
You can add a real-time turntable to the selected model, as follows:

1. Select the Turntable tool from the Main Toolbar.

2. To create a turntable for the selected model, click the On button on the left 
of the Turntable drop-down (see figure). Then control the turntable with 
the other controls in the drop-down, from left to right:
– Play / Pause: Starts and stops the turntable.
– Slower: Causes the turntable to spin slower (Ctrl-,)
– Faster: Causes the turntable to spin faster (Ctrl-.)
– Reverse Rotation: Causes the turntable to reverse directions 

(Ctrl-Alt-T)
– Reset Position: Rests the turntable (and model) to its original 

position (Ctrl-Shift-R)
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3. To remove the selected turntable, click the Off button on the left of the 
drop-down (or use the Ctrl-Shift-T hot key). To toggle the visibility of the 
selected turntable, press Ctrl-T.

SELECTION TOOLS
Selection Tools let you choose what will be selected when you left-click an 
object, or part of an object:

• Model: When enabled, LEFT-CLICK a model to select it.

• Part: When enabled, LEFT-CLICK a specific part in a model to select just 
that part.

• Group: When enabled, LEFT-CLICK a specific part in a model to select 
the group containing that part.

• Material: When enabled, LEFT-CLICK a material on a model to select the 
material and display its properties in the Material Tab of the Palette.
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OBJECT MANIPULATION TOOLS
Brings up the Transform Manipulator to visually Move, Scale, or Pivot (i.e. 
rotating) the selected model or material, as illustrated below.

Move

• If the Selector Tool is in Model Mode: Activating the Move Transform Tool 
displays the Transform Manipulator for visually Transforming Models, as 
well as the Model Tab for numerically transforming models. (By 
“transforming” we mean moving in 3D, as well as rotating around all 3 
axes.) Note:
– Right-clicking and dragging the center yellow square of the Move 

manipulator “sticks” the selected object onto any other object you 
drag it over. This feature is useful for placing object on a table for 
instance. It uses the selected objects’ pivot point as its “base,” so 
moving the pivot to the bottom of the bounding box is recommended.

• If the Selector Tool is in Material Mode: Activating the Move Transform 
Tool displays the Texture Manipulator for visually Mapping Textures onto 
parts in models, as well as the Material Tab for numerically mapping 
textures.

Scale
The Scale Transform Tool works the same as the Move Transform Tool 
(above), except it scales instead of moving or rotating.

Pivot
The Pivot Transform Tool works the same as the Move Transform Tool 
(above), except it acts on only the pivot point of the selected object.

CAMERA CONTROLS
Select the Camera Control Tool to set the camera’s behavior from the 
following options (left to right in the screen shot). For details, see “The 
Camera” on page 57.

• Rotate

• Pan

• Zoom

• Twist

• Look At

RENDER TOOLS
Select the Render Tools button to access the following types of rendering, and 
display a dialog with relevant options. For details, see “Outputting Images” 
on page 101.

• Snapshot

• Render
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• Animation

• Turntable

• Sun Study

Camera Toolbar / Panel
The Camera Toolbar and related properties are in a floating panel that 
provides controls to quickly switch between front, back, far side, near side and 
top and bottom cameras. Controls:

• Perspective Selector: (Note that pressing the Revert button returns your 
camera to the state it was in prior to using any of the following arrows.)
– Click the left side of the Perspective Selector to display the open 

scene from the left;
– Click the right side of the Perspective Selector to display the open 

scene from the right;
– Click the top of the Perspective Selector to display the open scene 

from the front;
– Click the bottom of the Perspective Selector to display the open 

scene from the back;
– Click the center of the Perspective Selector to display the open 

scene from overhead.

• Drop-Down Menu: Select any preset camera from the drop-down menu 
to display the scene in the 3D Viewport using that camera.

• (+) creates a new camera preset

• (lock icon) locks / unlocks the current camera

• More Options: opens the camera’s properties.

• Filter Effects: select an icon to apply the desired camera effect to the 
loaded scene. For example, select “Sepia” to create a look similar to 
antique film.

PALETTE

The Palette contains various tabs corresponding to the following modes:

• Model / Objects Tab

• Material Tab

• Scenes Tab

• Cameras Tab

• Library Tab

• Color Picker
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You can undock the Palette and move it around the screen separately from 
the main  DriveSuite Window, and then re-dock it later if desired. To undock 
the Palette, LEFT-CLICK-HOLD the top bar of the Palette, and drag it away 
from its dock. To re-dock the Palette, drag-and-drop it the same way onto the 
arrow on the far right side of the main  DriveSuite window, where it is normally 
docked.
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Model / Objects Tab
The Model (and Parts) Tab of the Palette provides you with the following 
options for selecting and transforming models and their parts:

MODEL / OBJECTS TREE
The names of the Models in your scene, and the parts within each Model, 
appear in the Model Tree near the top of the Model Tab in the Palette.

• In the drop-down list near the top of the Model Tab, select the Model Set 
containing the models you want in your scene. Notes: 
– A Model Set is a collection of one or more 3D objects.
– Different Model Sets are entirely separate, except when several sets 

contain the same model.
– A given Model Set can optionally be part of a custom configuration, 

but not part of the base configuration.

• To select a Model and display its parameters in the Model Tab:
– Option 1: Click the target model in the Model Tree of the Model Tab.
– Option 2: Set the Selection Tool (in the Toolbar) to Model Mode, and 

click the target model in the scene.

• To select a Part and display its parameters in the Model Tab:
– Option 1: Click the target Part in the Model Tree of the Model Tab.
– Option 2: Set the Selection Tool (in the Toolbar) to Part Mode, and 

click the target part in the scene.

When a Model is selected, it is outlined in yellow.

When a Part is selected, it is outlined in blue.

OBJECT PARAMETERS
Select a model, or its root joint, or one or more of its parts to display and 
optionally modify their parameters. Note that parts have some parameters 
that whole models do not, and vice versa, but they share most parameters. 
The Root joint in a model has a few unique parameters as well. 

The following lists all parameters affecting models, roots, and/or parts:

• Name: Type over the name of the selected object to change it.

• Hidden: Toggles the visibility of the selected object in the 3D Viewport. 
(Note: Emissive shaders still emit light into a scene even when their parts 
are hidden.)

• Disabled: When enabled, the selected model or part no longer affects 
lighting, but it does remain visible.

• Faded: Hides a model from the camera’s view, but leaves it in the scene 
in terms of lighting.

• Corner Radius: Adds a visual fillet or radius to parts with hard edges for 
visualization purposes. The edge then produces a more realistic highlight 
without requiring a modeled radius.
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• Symmetry: Mirrors the selected object across the specified axis. This is 
useful for symmetric object because you can import just half the object 
(have the number of triangles) and instance their symmetric data.

• Rotate (X+90, Y+90, Z+90): LEFT-CLICK one of these buttons to rotate 
the selected object by 90-degrees around the selected axis.

• Flip: Reverses the orientation of the object around the selected axis.

• Pivot Center:
– Model or Root or Part: Moves the pivot point of the selected model or 

root joint or part to the center of its bounding box.
– Environment: Moves the pivot point of the selected item to the center 

of the environment.

• Snap to Ground: Moves the object so it rests on the ground.

• Center: Moves the object to the center of the XZ-plane.

• Auto Size: Automatically sizes the object to best fit within the 
environment, and locates the object at the world origin.

• Reset: Moves the object to the location it was first imported into the open 
project, and returns it to its scale upon initial import.

• Part/Normals Control: Edits and rebuild the normal vectors on the 
selected part. For details, see “Part/Normals Control” on page 78.

• Transform: Provides parameters for numerically translating, rotating, 
scaling, and pivoting the selected model or part:
– Position XYZ: Translates the selected item in 3D space.
– Rotation XYZ: Rotates the selected item in 3D space.
– Scale XYZ: Scales the selected item by axis in 3D space.
– Scale All: Scales the selected item proportionally in 3D space.
– Reset: resets the model and all its parts to its original coordinates.
– Freeze: leaves the model in place, and sets all transform values to 

neutral (i.e. Position = 0,0,0 and Size = 1.0 etc)
– Pivot XYZ: Translates the pivot point of the selected item.
– Pivot Rotation: Rotates the pivot point of the selected item.
– Reset: resets the pivot to its original coordinates.

• Follow: Causes the camera to follow the model you select in the drop-
down menu.

• Physics: These parameters determine how the selected model reacts to 
gravity and collisions in the scene. 
– Physics Type: 

» None disables physics entirely for the selected model.
» Static locks the selected model in its current location, while 

allowing other models with dynamic physics to collide with it.
» Dynamic lets the model react to gravity and collisions with 

accurate simulation of motion and dynamic impact. Dynamic 
physics can be recorded, then combined and played back with 
other animations. The Mass parameter defines the dynamic mass 
of the selected model.

» Car activates full dynamic physics for vehicle models.
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– Collision Type: 
» Bounding Box: Uses an invisible rectangular bounding box 

around the selected model to calculate collisions. This method is 
fast, but not as accurate.

» Mesh: Uses the mesh of the selected model to calculate 
collisions. This method is computationally slower, but more 
accurate.

• Vehicle Setup: These parameters help you make an imported vehicle 
driveable:
– Vehicle Facing: select the direction (i.e. axis) the front of the vehicle 

is facing from the drop-down list. 
– Create Wheels from Selected Parts: After first selecting all the 

rotating parts in the wheels of your vehicle, click this button to 
enabled those wheels to spin and rotate when driving. (NOTE: 
Calipers do not rotate, so don’t select them.)

– Create Calipers from Selected Parts: After first selecting all the 
parts in the brake calipers of your vehicle, click this button to enabled 
those calipers to rotate with the wheels as you turn them.

• Rasterization Options:
– Enable Ground Shadows: Toggles ground shadows that are 

generated in realtime from the HDR environment image. You can 
control the intensity of the shadows via the Environment Shadow 
Intensity slider in the Scene Tab of the Palette.

– Show Wireframe: Toggles visibility of the tessellated polygons in the 
selected part or model.

– Reflect Other Models: When enabled, the selected model reflects 
other models in the scene, with some impact to performance.

– Reflect in Other Models: When enabled, the selected model is 
reflected in all other models in the scene. This feature complements 
the Reflect Other Models feature (above).

– Visibility: Controls the directional culling (i.e. selective removal from 
rendering) of one side (front or back) of the selected part mesh. The 
default of “All” culls nothing. “Clockwise” usually culls the backside of 
the mesh, and “Counter Clockwise” usually culls the front side, 
depending on how the normals are aligned in the part.

• Baked Lighting: While in real-time raster mode, you can still see most 
objects with high quality lighting baked in. Simply select the part(s) you 
want to be realistically lit with the Parts Tool, and select either Vertex or 
Texture Lighting to bake raytraced lighting into the selected parts:
– Enable Baked Lighting: Toggles the visibility of baked lighting 

without removing it from the selected parts.
– Vertex Lighting calculates global illumination and applies the results 

to each vertex in the selected part(s). This technique works very well 
for high-polygon models, but it can take some time. Options:
» Accurate: Uses the color, intensity, and direction of light from the 

HDR environmental image for very accurate results.
» Approximate: Reduces the loaded HDR to non-directional light 

and calculates baked lighting based on the occlusion of other 
parts and objects in the scene.
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– Texture Lighting calculates global illumination and applies the 
results to a texture, which is then mapped onto the selected parts. 
This technique works well for low-polygon models, but does not 
exploit the polygonal detail in high-poly models. Options:
» Low / Normal / High: “Low” generates a baked texture of 64x64 

pixel resolution. “Medium” generates a texture of 256x256. “High” 
generates a texture of 1024x1024.

» Accurate / Approximate: “Accurate” uses a more accurate but 
slower algorithm. “Approximate” uses a faster but less accurate 
algorithm.

– Approximate Shadow Intensity: If you select “Approximate” from 
the calculation options above, then you can control the intensity of 
generated shadows here.

– Remove Baked Lighting: Clears baked lighting from selected parts.

• Tessellation: Select the part you want to re-tessellate, choose the new 
tessellation value in this “Tessellation” section of the Model Palette, and 
click the Re-Tessellate button to re-tessellate the selected part. NOTES:
– The “Tessellation” section of the Model Palette is available only when 

you select a part in a model that was imported from geometry that 
needed to be tessellated (e.g. .wire, .sldprt, .sldasm, .3dm, .asm, 
etc.). If you select a part that was in a model imported from pre-
tessellated geometry, such as .obj, then the Tessellation section will 
not be available.

– You can re-tessellate a part only if the original model (prior to import) 
is still in the same relative location to the Bunkspeed project file.

• Texture Mapping: Controls how textures are mapped onto the selected 
part. For details, see “Texture Mapping on Parts” on page 79.
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Material Tab
The Material Tab of the Palette provides you with the options discussed in this 
section. When you select a material on a model, the material is highlighted in 
orange.

MATERIAL TREE
Each and every material in the open project is listed in the Material Tree near 
the top of the Material Tab. Display options: tiles, thumbnails, or text lists.

1. To select a material and display its parameters, LEFT-CLICK its name or 
icon in the Material Tree (see image to the left).

2. To apply a material to part in a model in the 3D Viewport, DRAG-AND-
DROP the material from the Material Tree to the target part.

MATERIAL PARAMETERS
When you select a specific material in the Material Tree (or select a material 
on a part in a model), the parameters defining the material appear in the 
Material Tab of the Palette. Exactly which parameters appear and depends on 
the type of the selected material (e.g. glass, metal, leather, etc). Different 
parameter values for the same type of material produce variations within the 
type (e.g. silver verses gold).

You cannot create new types of materials, but you can edit the values of 
material parameters to create unique variations within each type.

All materials in Bunkspeed  DriveSuite share the following parameters:

• Material Name: An arbitrary name for the material. You can optionally 
overwrite the default name.

• Material Type: The type (i.e. category) of material – such as glass, 
metallic paint and plastic. Different types of materials have different 
parameters that appear here. For a list of all types of materials supported 
by Bunkspeed DriveSuite, with details on the parameters for each type, 
see “Types of Materials in Bunkspeed DriveSuite” on page VII.

• Color: The base color of the material. Usually white.

Texture Parameters
Expanding the Texture parameters near the bottom of the Material Tab allows 
you to add Color, Specular, Alpha, and Bump textures to the selected 
material. (For usage instructions, see Add and Edit Texture Materials.)

After you load a texture for a material, you can tune its parameters. When you 
apply a material with one or more textures to an object, Bunkspeed  
DriveSuite maps the textures onto the selected parts in the target object. 

• Sync Textures: Once you fill in the values for one type of mapping, select 
this option to copy those values to the other types of mapping (assuming 
the other types have loaded textures).

• Color, Specular, Alpha, or Bump: Allows you to load a texture of the 
selected type: Color, Specular, Alpha, or Bump. (This option appears only 
if you have not already loaded a texture of this type.)
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The following parameters appear after you load a color, specular, alpha, or 
bump texture to the selected material:

• Enable Texture: Turns on/off the texture that has already been loaded. 
(This option appears only if a texture of the selected type has already 
been loaded.)

• Blend Texture: (Color and Specular textures only) Combines the loaded 
image with the color of the material itself in an additive fashion that allows 
you to tint textures.

• Brightness: Changes the reflectivity of the loaded specular map itself.

• Tile (U, V): The default of (1, 1) causes exactly one copy of the texture to 
be mapped, from edge to edge, across each target part. Values greater 
than “1” cause tiles of the texture to repeat across each part. For 
example, a value of (2, 2) causes the texture to repeat twice along each 
axis, forming a 2x2 grid of tiles across the surface of each host part.

• Shift (U, V): Offsets the center of the texture in horizontal (U) and vertical 
(V) directions, relative to the normalized texture coordinates on the host 
part. The default of (0,0) centers the texture on the part.

• Repeat (U, V): Toggles between single and multiple copies of the texture. 
per axis.

• Rotation: Rotates the texture in texture space on the target surface.

• Bump Scale: (Bump textures only) Determines the height of the bumps. 
Negative values give the impression of engraving. 

• Invert Bump: (Bump textures only) When inverted, hills in the bump 
texture become valleys, and valleys become hills.

• Treat as Normal Map: (Bump textures only) When you first add a bump 
or normal texture,  DriveSuite makes an educated guess about which 
type it is (indicated by the half-checked box for this parameter). When 
using actual normal maps, you can manually select Normal Maps by fully 
checking this box. Otherwise, use Treat as Normal Map to toggle between 
Bump Mapping and Normal Mapping, and select whichever produces the 
best results.

• Treat Bumps as Displacement: Converts the highlights and shadows in 
the greyscale bump texture to actual 3D displacement. This adds realism 
by adding actual physical depth to the bump texture!
– Technical Note: When making the conversion from 2D to 3D, the 

application re-tessellates the underlying geometry to add 2 triangles 
to every pixel on the texture mapped to that geometry. For high detail 
textures, you will need a lot of RAM or vRAM.

• Remove Texture: Removes the texture of the selected type (i.e. if 
Specular is selected, this button removes the Specular texture.

• Load New Texture: Loads another texture of your choosing.

• Save Texture As: Saves the texture to disc.
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• Create New Decal: Creates a decal from the selected texture(s).

Texture Mapping Parameters
Expand to display parameters for texture mapping, as explained in “Texture 
Mapping on Parts” on page 79.

Save Material Parameters

• To Library: Saves the selected material to the Material Library using the 
Bunkspeed Material File format. This action makes the material readily 
available to other  DriveSuite projects on the same PC.

• To File: Saves the selected material to an arbitrarily folder using the 
Bunkspeed Material File format. This action makes it easy to share 
materials with other  DriveSuite users.

• Reset Material: Resets the material to the state it was in before you 
started making edits to it.
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Scenes Tab
The Scenes Tab of the Palette provides you with options for applying and 
managing HDR images that provide environmental lighting, and doing the 
same backplate images that provide a backdrop to your scene without 
affecting its lighting.

SCENE TREE
Every HDR environment image loaded into the open project is listed near the 
top of the Scene Tree in the Scenes Tab. Backplates are listed in the Scene 
Tree below loaded environment images. These image lists can take the form 
of tiles, thumbnails, or text.

• To select an environment or backplate image and display its parameters, 
LEFT-CLICK its thumbnail in the Scene Tree.

• To switch to different environment or backplate image in the open project, 
DOUBLE-LEFT-CLICK its thumbnail in the Scene Tree.
– Alternative: Drag-and-Drop the entry in the Scene Tree into the 3D 

Viewport.

• Right-click the thumbnail of an environment image to display options. One 
useful option is Copy Settings, which copies all the settings in this Palette. 
You can then right-click the thumbnail of another image, and select Paste 
Settings to copy the settings from the first image to the second.

HDR ENVIRONMENT PARAMETERS
When you select an HDR environment image in the Scene Tree, Bunkspeed  
DriveSuite displays the following parameters Scenes Tab. You can edit these 
parameters to tune the selected image.

• Show Environment Image: Toggles visibility of the environment image 
loaded in the 3D Viewport. Even when invisible, the loaded environment 
image still emits light into the scene.

• Name: The name of the environment image.

• Resolution: (read-only) The resolution in pixels of the selected 
environment image.

• Flatten Ground: When enabled, the environment becomes a half-
sphere. When disabled, the environment becomes a full sphere.

• Background Color: Determines the background color of the 3D Viewport 
outside the environment sphere. LEFT-CLICK the color to display a 
standard color picker.

• Brightness: Adjusts the overall brightness of the selected environment 
image.

• Gamma: Indirectly adjusts the contrast of the selected environment 
image.

• Size: Determines the radius, in meters, of the environment sphere.
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• Height: Shifts the loaded environment image vertically (up and down) on 
the environment sphere.

• Rotation: Rotates the loaded environment image on the environment 
sphere.

• Flip Horizontal: Flips the environment image horizontally (left / right) 
around a vertical axis in the center of the image.

• Ground Reflection: Adjust the visibility of the ground reflection where 0 
is off and 1 is full reflection.

• Ground Glossiness: Adjusts the roughness of the ground reflection 
where 0 is perfectly crisp and 0.5 is fully rough.

• Ground Shadow: Toggles the projection of shadows on the ground in 
both Performance and Raytrace Modes.

• Shadow Intensity: Drag to darken or lighten the environment ground 
shadow.

• Show Grid: Toggles visibility of a grid in the XZ-plane. (The grid is visible 
only when Raytrace is off.)

• New Sun and Sky Environment: As explained in “Create a New Sun 
and Sky Environment” on page 94, this special type of environment 
uses different parameters than those which appear above.

• Create New Backplate: Lets you import a new 2D backplate image, 
which can be in any supported file format. For details, see “Backplate 
Parameters” on page 48.
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LIGHT PARAMETERS
The following parameters appear when you select the icon of an existing light 
from the Scenes Tab, or you select the light icon in the scene itself:

• Light Name: An arbitrary name for the light.

• Locked: If enabled, the light cannot be moved.

• Enabled: If enabled, the light affects the scene’s overall lighting.

• Type: Choose between several types of lights, such as point lights.

• Intensity: Determines the intensity (brightness) of the light.

• Color: Lets you set the color of the light with the Color Picker.

• Color Temperature: Lets you select the light’s color in degrees Kelvin.

• Area Light Size: Lets you set the radiant area of planar lights.

• Follow: Lets you set this camera to follow a specific model, such as a 
vehicle while you’re driving it.

• Transform: Lets you transform the position of the light numerically. (Note: 
You can also transform lights with the Transform Manipulator.)

• Rasterization Options: 
– Cast Shadows: If enabled, the light casts shadows in the scene. If 

disabled, the light does not cast shadows.

BACKPLATE PARAMETERS
When you select a previously loaded backplate image in the Scene Tree, then 
the following parameters appear:

• Visible: Toggles the visibility of the loaded backplate image.

• Name: The file name of the selected backplate.

• Resolution: (read-only) Displays the pixel width and height of the 
selected backplate image.

• Update Backplate: (Assumes Auto-Update is off) Manually updates the 
selected backplate image, so changes to the linked source image can be 
updated in your Bunkspeed project.

• Auto-Update (Activate): When activated, the selected backplate image 
will automatically update in your open Bunkspeed project, whenever you 
edit the source image in PhotoShop, HDR Light Studio, Filter Forge, or 
similar software.

• Fill Background: Stretches the backplate to fit within the aspect ratio set 
on the camera.

• Fit Camera Aspect Ratio: Adjusts the active camera's aspect ratio to 
match that of the selected backplate.
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• New HDR Environment: imports a new HDR environment image.

• New Sun and Sky Environment: Lets you Create a New Sun and Sky 
Environment.

CONTEXT-SENSITIVE SCENE MENU
Right-click in the upper area of the Scene Tab to display a context-sensitive 
menu that includes the following options for creating new scene elements:

– New HDR Environment
– New Sun and Sky Environment
– New Backplate
– New Light
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Cameras Tab
The Cameras Tab of the Palette provides you with options for creating, 
configuring, managing, and using various cameras to view and record your 
scene.

CAMERA TREE
Each camera in the open project is listed near the top of the Camera Tab. The 
Camera Tree can take the form of tiles, thumbnails, or text lists.

1. To select a camera for editing, LEFT-CLICK its name or icon in the 
Camera Tree.

2. To switch to different camera in the open project, DOUBLE-LEFT-CLICK 
its name or icon in the Camera Tree. DRAG-AND DROP works too.

CAMERA PARAMETERS

• Camera Name: An arbitrary name you can give a camera.

• Locked: When enabled, you cannot move the selected camera.

• Aspect Ratio: Sets the aspect ratio of the rendered area within the 3D 
Viewport. Type over these values to change them.

• Distance / Dolly: Determines the distance between the selected camera 
and the look-at point. You can also dolly / zoom the camera in several 
other ways, as explained in Zoom the Camera

• Azimuth: Rotates the selected camera around the look-at point. You can 
also rotate the camera in several other ways, as explained in Rotate the 
Camera.

• Incline: Moves the selected camera vertically.

• Twist: Tilts the selected camera left/right without moving its 3D position. 
You can twist cameras in other ways, as explained in Twist the Camera.

• Perspective: Controls the amount of perspective distortion in the 
selected camera by changing the focal length of its virtual lens. Smaller 
perspective values reduce perspective distortion, and increases the focal 
length of the lens. Larger values do the opposite.

• Position XYZ: The current 3D position of the selected camera, relative to 
the World Origin of the scene.

• Focal Length (mm): Controls the amount of perspective distortion in the 
selected camera according to an accurate simulation of optical physics in 
camera lenses. Although the 3D position of the camera remains 
unchanged, smaller values provide a wider angle of view and therefore 
seem to move the camera further away. Larger values do the opposite.

• Orthographic View: Toggles between perspective and orthographic 
cameras. When enabled, all perspective distortion is eliminated, 
regardless of the values of Perspective and Focal Length. 
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• Keep Above Ground: When enabled, you cannot move the camera 
below the ground in the open project. When disabled, you can move the 
camera anywhere – and a ring appears around the Top selector in the 
Camera Toolbar. Clicking this ring switches the perspective the camera to 
directly under the scene, looking up.

Post-Processing Options 
The following Post-Processing options add various photographic effects to the 
scene, when viewed through this camera. All imagery produced from this 
camera – including the real-time view in the Viewport, as well as snapshots 
and all types of rendering and animations – uses these settings:

• Enable Post-Processing: Activates post-processing of this camera view 
and all imagery that comes from it.

• Color Filter: Applies the selected color as a filter on the lens of the virtual 
camera.

• Vignette: Creates a soft shadow near the edges of the camera’s field of 
view. The vignette effect becomes stronger with cameras that have more 
perspective (in contrast to an orthogonal camera).

• Darken: Darkens the overall scene.

• Lighten: Lightens the overall scene.

• Saturation: Increases / decreases the color saturation of the image.

• Exposure: Increases / decreases the density (brightness) of the 
scene.Gamma Correction: Sets the gamma of your monitor.

• Brightness: Makes the overall scene brighter, so as to add detail to 
shadows.

Depth of Field
Depth of Field is the rate that blur increases for objects further from the focal 
plane. Controls:

– Enable Depth of Field: Toggles the calculation of depth of field.
– Focal Distance: The distance between the camera and the point of 

optimal focus.
– Aperture (mm): Uses millimeter to set the diameter of the opening in 

virtual lens of the selected camera.
– F-Stop: Uses F/stop to set the diameter of the opening in virtual lens 

of the selected camera.

Follow
The parameters in this section let you separately specify a model for this 
camera to follow, and a model for this camera to aim at.

Region Options

• Enable Region: Lets you render a region within the selected camera, but 
only when you do renderings with that camera. Usage: Select Enable 
Region for the current camera, and crop the Viewport to the region 
constraining renderings. You can do this in two ways:
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– Either select and drag the white dots that appear when you have 
enabled a region for cropped rendering;

– or enter the desired pixel dimensions in the palette.

Motion Blur
Motion Blur is available only for raytracing (either realtime or offline).

• Enable Motion Blur: Activates Motion Blur for the selected camera. The 
Motion Blur is the sum of motion from an animated camera and geometry.

• Shutter Time (ms): The quantity of Motion Blur.

Camera Positioning
These parameters let you view an overlay showing the distance between the 
World Origin and the cameras you select in the Cameras Tab of the Palette. 
The distances will be accurate provided the model scale in your scene is 
accurate. To use this feature, you must be viewing the scene from another 
camera entirely. 

• Show in Viewport: If enabled, the distance of this camera to the World 
Origin will be shown in the Viewport.

• Height from Ground: Allows you to move the camera’s height above the 
ground in your scene.

• Ground Distance: Allows you to move the camera horizontally closer to, 
or further from, the World Origin of your scene.

• Focal Height: Allows you to set the height of the camera’s focal plane, 
relative to the ground in your scene.

Rule of Thirds Overlay
This feature toggles an overlay of a Thirds Ruler or Quarters Ruler to aid 
with composition when using this camera. You can configure the Grid Line 
Color to your preference.

Miscellaneous

• Reset Camera: Resets the camera to the factory defaults.

• Save Camera File: Saves the selected camera to the Cameras Library, 
using the Bunkspeed Camera File format. You thereby have the option to 
load this camera in a separate project, and share the camera with other  
DriveSuite users.
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Library Tab
By default, the Library Tab of the Palette provides you with the means to 
import and manage files in your local libraries (see list below).

– Camera Library
– Environments Library
– Image Library
– Materials Library
– Models Library
– Plates Library
– Project Library
– Texture Library
– Web Libraries

• If you are logged on, you can choose between the Local library in the 
Bunkspeed Content folder on your hard drive, and Web Libraries on 
Bunkspeed’s servers, by clicking their respective buttons near the top of 
the Library Tab. Local and web libraries use the same names by default, 
but they are totally separate. By copying items from the to your Local 
library, you can add to your local collection. To prevent copying the same 
item more than once, items in the Web library that you already have a 
copy of are tagged with a green check.

• In the Palette, near the top of the Library Tab is a search option and a 
triangle. If you LEFT-CLICK the triangle, something like Windows 
Explorer will appear so you can create sub-folders and organize your 
items in your local libraries. These sub-folders will be created under 
Bunkspeed Content folders on your hard drive. For example, you can 
create new sub-folders in the Material folder, so you can organize your 
materials however works best for you.

• A list of the items in a library occupies the entire lower space of the 
Library Tab.

• You can change the default folders for the Libraries in two ways:
– Either edit the paths in the General Tab of the Options Dialog;
– or drag new folder from Windows Explorer into the target libraries in 

the Library Tab of the Palette (one library at a time).

CAMERA LIBRARY
The Camera Library contains images in the Bunkspeed Content \ Cameras 
folder, by default.

1. To load a library camera into the open project, DRAG-AND-DROP it from 
the Camera Library into the 3D Viewport. Once loaded, the camera will be 
saved with the project (i.e. added to the list of cameras in the Cameras 
Tab of the Palette), and become independent of the Camera Library.
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ENVIRONMENTS LIBRARY
The Environments Library contains high dynamic range images in the 
Bunkspeed Content \ Environments folder, by default.

1. To apply the image to the environment of the open scene, DRAG-AND-
DROP an HDR image file from the Environments Library to the 3D 
Viewport. Once applied, the HDR image will be saved with the project (i.e. 
added to the list of HDR images in the Environments Tab of the Palette), 
and become independent of the Environments Library.

IMAGE LIBRARY
The Images Library contains images in the Bunkspeed Content \ Images 
folder, by default. The Images Library is where  DriveSuite saves screenshots 
and renderings.

1. DOUBLE-CLICK an image in the Image Library to display a larger view of 
the image in the Image Viewport.

MATERIALS LIBRARY
The Materials Library contains the material files in the Bunkspeed Content \ 
Materials folder, by default.

1. To apply the material to a part on a model, DRAG-AND-DROP the 
material from the Materials Library to the target part in the 3D Viewport. 
Once applied, the material will be saved with the project (i.e. added to the 
list of materials in the Material Tab of the Palette), and become 
independent of the Materials Library.

MODELS LIBRARY
The Objects Library contains the model files in the Bunkspeed Content \ 
Models folder, by default.

1. To add the model to the open scene, DRAG-AND-DROP the target model 
file from the Objects Library into the 3D Viewport. Once added, the 
model will be saved with the project (i.e. added to the list of models in the 
Model Tab of the Palette), and become independent of the Model Library.

PLATES LIBRARY
The Plates Library contains the backplate images in the Bunkspeed Content \ 
Plates folder, by default.

1. To apply an image to the backplate of the open project, DRAG-AND-
DROP the target image from the Plates Library into the 3D Viewport. 
Once applied, the image will be saved with the project (i.e. added to the 
list of images in the Scenes Tab of the Palette), and become independent 
of the Plates Library.
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PROJECT LIBRARY
The Project Library contains the project files in the Bunkspeed Content \ 
Projects folder, by default.

– To load a project in Bunkspeed  DriveSuite, DRAG-AND-DROP a 
project file from the Project Library to the 3D Viewport.

TEXTURE LIBRARY
The Textures Library contains the images in the Bunkspeed Content \ 
Textures folder, by default. These images are intended for use as textures in 
materials.

Local / Web 
Buttons

WEB LIBRARIES
After you log in, the Local and Web buttons appear in the upper right of the 
Library Tab in the Palette. Use these buttons to switch between your Local 
library and the Bunkspeed web library.

Here’s how you log into the Bunkspeed web library:

1. Select the login prompt in the upper right corner of the Bunkspeed  
DriveSuite window, and the Login to Bunkspeed screen will appear. 

2. In the Login to Bunkspeed screen, enter the email address and 
password you used to obtain a license to Bunkspeed DriveSuite. If you 
are using a trial version, you can click Register to create an account to 
the Bunkspeed library.
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Color Picker
The Color Palette is available in various Tabs and several dialog boxes. 

You can select the Color Palette from wherever a color parameter appears. 
For example, when you select a material in the Material Tab, its Color 
parameters appear as strips of color. Clicking any of these Color parameters 
displays the Color Palette for editing that color.

The Color Picker has all the standard controls, plus an eyedropper that lets 
you sample colors anywhere on your screen – even outside the Bunkspeed  
DriveSuite window! Usage:

1. Click and hold down the left mouse button over the target color. (Note: 
The rectangular window with the little red box is a deep zoom of what you 
have the color dropper over.)

2. Let go of the left mouse button to select the color you are hovering over.

CONTEXT SENSITIVE MENU

For convenience, Bunkspeed  DriveSuite provides a context sensitive drop-
down menu that appears when you RIGHT-CLICK various things in the user 
interface. The options in the Context Sensitive Menu change according to the 
active tool, your selection, and other circumstances.

The Context Sensitive Menu provides quick access to commonly used tools 
that can be invoked in other ways, as explained elsewhere in this Guide. In 
most cases, the Context Sensitive Menu does not provide you with any 
unique options; it just makes some common options more accessible.
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THE CAMERA

This section describes how to use the camera in Bunkspeed DriveSuite. 
Controls for the current camera are in the free-floating Camera Toolbar. (For 
background on the Camera Toolbar, see “Camera Toolbar / Panel” on 
page 37.

Camera Toolbar

Camera Selector in the 
Main Menu

Automatic Perspectives
Use Perspective Selector on the far left side of the Camera Toolbar (see 
figure above) to switch between front, back, far side, near side and top and 
bottom cameras with a single click:

• Click the left side of the Perspective Selector to display the open scene 
from the left.

• Click the right side of the Perspective Selector to display the open scene 
from the right.

• Click the top of the Perspective Selector to display the open scene from 
the front.

• Click the bottom of the Perspective Selector to display the open scene 
from the back.

• Click the center of the Perspective Selector to display the open scene 
from overhead.
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Basic Camera Movements
Using the Camera Selector in the Main Toolbar (see figure above), you can 
Rotate the Camera, Pan the Camera, and Zoom the Camera relative to its 
look-at point (i.e. the point in the scene that the camera is focused on). You 
can also Change the Look At Point, and Save a Camera to a File, among 
other things.

By default, the camera is restricted to moving above ground. To let the 
camera move below the ground, de-select Keep Above Ground in the 
Camera Tab of the Palette.

ROTATE THE CAMERA
This option rotates the camera around the selected look-at point:

1. To rotate the camera around the look-at point, HOLD both the Alt-Key 
and LEFT MOUSE BUTTON, and then DRAG the MOUSE.
– Alternative: LEFT-CLICK the Camera Selector in the Toolbar, and 

select the Rotate icon (see figure). Then LEFT-CLICK-HOLD and 
DRAG the MOUSE without holding the Alt-Key.

PAN THE CAMERA
Panning the camera moves it left/right and up/down in the current viewing 
plane. The camera keeps pointing in the same direction, and the look-at point 
moves with the camera.

1. To pan the camera, HOLD both the Alt-Key and MIDDLE mouse button, 
and DRAG the MOUSE.
– Alternative: LEFT-CLICK the Camera Selector in the Toolbar, and 

select the Pan option (see figure). Then LEFT-CLICK-HOLD and 
DRAG the MOUSE without holding the Alt-Key.

ZOOM THE CAMERA
Zooming the camera moves the camera closer to or further away from the 
object, while pointing in the same direction. (Technically this is a “dolly” 
camera, but the term “zoom” is more widely understood.)

1. To zoom the camera, HOLD both the Alt-Key and RIGHT mouse button, 
and DRAG the MOUSE.
– Alternative 1: LEFT-CLICK the Camera Selector in the Toolbar, and 

select the Zoom option (see figure). Then LEFT-CLICK-HOLD and 
DRAG the MOUSE without holding the Alt-Key.

– Alternative 2: Change the Distance/Dolly parameter in the Camera 
Tab of the Palette.
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TWIST THE CAMERA
Twisting the camera rotates it clockwise / counterclockwise in the 2D plane of 
the screen:

1. To do a 2D twist around the center of the 3D Viewport, select the Twist 
option from the drop-down Camera Control in the Toolbar (see figure), 
and DRAG THE MOUSE without holding down the Alt-Key.
– Alternative: Change the Twist parameter in the Camera Tab.

CHANGE THE LOOK AT POINT
The Look-at point acts like a pivot point for the Rotate and Zoom methods of 
moving the camera.

• To set a new look-at point, LEFT-CLICK the Camera Selector in the 
Camera Bar, and select the Look-At option. Then do one of the following:
– LEFT-CLICK the desired location of the new look-at point in the 3D 

Viewport. The camera will move in order to center the new look-at 
point in the Viewport.

– Hold the SHIFT+ALT key and RIGHT-CLICK the desired location of 
the new look-at point in the 3D Viewport, in order to change the look-
at point without moving the camera.

• Notes:
– Panning the camera moves the look-at point with the camera.
– To change the perspective of the camera, hold down the Alt-key while 

using the scroll wheel.

Additional Camera Controls

RESET THE CAMERA
Resetting a camera restores its position and the look-at point to the World 
Origin, and sets the focal length and other camera parameters to their default 
values.

1. To reset the active camera, press the Reset Camera button in the 
Camera Tab of the Palette.

LOCK / UNLOCK

1. To prevent the current camera from moving, select the Locked button in 
the Camera Tab of the Palette.
– Alternative: Select the desired camera in the Camera drop-down list 

in the Toolbar, and toggle the Lock icon next to the list.
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USE CAMERA PRESETS
Making a camera preset allows you to return later to the exact position and 
settings of the current camera.

1. To preset the current camera, LEFT-CLICK the plus (+) next to the 
Camera drop-down menu in the Toolbar.

2. To return to any recorded Preset, select the desired Preset from the 
Camera drop-down menu in the Toolbar.

SAVE A CAMERA TO A FILE
The current settings and position of the active camera can be saved to a file, 
which makes it easy to share cameras with other  DriveSuite projects and 
other users.

1. To save the active camera to a file, LEFT-CLICK the Save Camera File 
button in the Camera Tab of the Palette.  DriveSuite saves the camera to 
the Camera Library, by default.

ANIMATION TIMELINE AND CONTROLS

The following figure shows the animation timeline on the right, and various 
animation controls above and to the left of the timeline. The text in this section 
describes each control. For background information on animation, and usage 
instructions for the controls below, see "Chapter 7: Working with 
Animations” on page 97.

Basic Animation Controls Advanced Animation Controls

Animation List Timeline
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Basic Animation Controls
Here are the following basic controls, from left to right in the Timeline:

• Minimize / Restore Timeline: Displays or hides controls for creating and 
editing animations. When most of the controls are hidden, the playback 
controls are all that’s visible.

• Time / Frames Toggle: Click the “T” or “F” to toggle between time and 
frame count.

• Start Frame: Click to return the current time to the first frame of the 
selected animation.

• Previous Frame: Click to play the selected animation backwards, one 
frame at a time.

• Play / Pause Backwards: Click to play or pause the selected animation 
backward.

• Play / Pause Forwards: Click to play or pause the selected animation 
forwards. 

• Next Frame: Click to play the selected animation forwards, one frame at 
a time.

• End Frame: Click to change the current time to the last frame of the 
selected animation.

• Show/Hide Advanced Settings: Toggles visibility of the Advanced 
Animation Controls.

Advanced Animation Controls
The following advanced controls appear directly above the Timeline only 
when the Advanced Animation Controls button is enabled in the Basic 
Animation Controls.

• Turtle, Hare, and Playback Multiplier: The number followed by an “x” 
indicates the relative rate of playback of the selected animation:
– A value of “1.0x” indicates playback at exactly that defined in the 

Frames-Per-Second control (see below).
– A value of “0.5x” indicates playback at half the rate defined in the 

Frames-Per-Second control.
– A value of “2.0x” indicates playback at double the rate defined in the 

Frames-Per-Second control.

• Stopwatch: Toggles auto-keyframing on/off.

• Auto-Fit to Last Frame: If enabled, the red End Flag in the Timeline is 
locked to the last keyframe of the longest animation in the open project.

• Loop Playback: Interpolates between the last keyframe and the first, so 
the selected animation repeats seamlessly.
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• Workspace Flags: Drag these orange flags to the start and end times of 
the selected animation.

• Frames-Per-Second: Displays the rate of playback in frames-per-
second.

Animation List
Under the Basic Animation Controls appears a list of existing animations. 
This Animation List contains the following information and additional controls, 
from left to right:

• Visibility Toggle: Toggle the eye button to enable / disable the target 
animation.

• Lock Toggle: Toggle the lock button to enable / disable the ability to edit 
the target animation.

• Ribbon Toggle: Toggle to show / hide the Animation Ribbon for the 
selected animation. (Note: For camera animations, the Animation Ribbon 
is visible only if you’re viewing the scene through a different camera than 
the one being animated.)

• Name: The name of the target animation. Click the name to change it.

• Arrows (to the right of the animation Name): Click to move the Current 
Time forward or backward one keyframe.

• Key: Click to add a keyframe at the Current Time.

GENERAL ANIMATION PROPERTIES
When you double-click an animation from the Animation List, its properties 
appear in the palette below:

• Name: The arbitrary name of the selected animation.
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• Loop: Can be one of the following:
– Clamp: Play one loop of the animation, and then stops.
– Loop: Repeats animation loop indefinitely.
– Loop with Offset: Repeat animation from an offset point in space, so 

the animated objects shift in space with each loop.
– Mirror: Loops the animation in both directions (e.g. start to end, then 

end to start, etc.)

• Loop Time: Sets the time when clamped animations return to their 
starting frame.

• Interpolate Using Shortest Distance: Forces linear transforms between 
keyframes (i.e. so the animated object moves in the most linear path 
between keyframes). This feature is on by default; turn it off for rotation 
animations that span more than 180 degrees.

• Enabled: Enables / disables playback of the animation and output.

• Locked: When locked, animations can’t be edited.

Animation Ribbon
The Animation Ribbon appears for the animation that’s actively selected in the 
Timeline, provided you have raytracing turned off. The color coding of the 
Ribbon shows green when the animation accelerates, yellow when the 
animation is slowing, and red when then animation pauses. The properties of 
the Animation Ribbon are as follows:

• Show in Viewport: Toggles visibility of the Animation Ribbon for the 
selected animation.

• Thickness: Sets the thickness of the Animation Ribbon.

• Segment Strength: Sets the length between bricks in the Ribbon.

• Toggle Ribbon Orientation: Turns on the direction of focus for the object 
following the Ribbon by turning the bricks to arrows.
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ROTATION ANIMATION PROPERTIES
In addition to General Animation Properties, rotation animations have the 
following specific properties:

• Axis of Rotation: Lets you select the axis around which to rotate the 
target object. (Note: This axis is the local axis of the object itself.)

• Center of Rotation: Lets you specify an exact center of rotation via an 
(x, y, z) coordinate in 3D space.

• Total Rotation: Lets you specify the total angle of rotation, in degrees.

• Ease In: Lets you optionally specify acceleration / deceleration as the 
animation approaches the next keyframe.

• Ease Out: Lets you optionally specify acceleration / deceleration as the 
animation exists the last keyframe.

Animation Timeline
The following advanced controls appear in the Timeline for the selected 
animation:

• Red Flag: Marks the time that playback stops. This time could be at, or 
well past, the final keyframe.

• Yellow Flag: Marks the Current Time.

• Orange Flags: Marks the start and stop times of the workspace for the 
selected animation.

• Keyframes: Each icon within the timeline of a specific animation 
represents a keyframe. Double-click a keyframe to display advanced 
keyframe properties (see below).
Copyright © Bunkspeed, Inc. 2002-2014 64



Bunkspeed  Drive Suite User Guide Overview of the User Interface Animation Timeline and Controls
KEYFRAME PROPERTIES
When you double-click an existing keyframe in the Timeline, its properties 
appear in the dialog below:

• Time Point: Lets you set the exact time of the selected keyframe.

• Transition In / Out: Select from the following transitional options:
– Smooth: (default) Interpolates curves between keyframes.
– Linear: Interpolates a straight 3D line between keyframes.
– Flat: Interpolates a straight 2D line between keyframes.
– Hold: Freezes the object for the duration of the keyframe.

• Tension In / Out: For the selected keyframe, Tension lets you tune the 
curvature of incoming and outgoing motion.

• Motion Ease In / Out: Lets you accelerate or decelerate the animation as 
it approaches (In) or exits (Out) the selected keyframe.
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Chapter 4: Working with 3D Models

You can load multiple 3D models into your Bunkspeed  DriveSuite project. (In 
this document, models, objects, and meshes are all the same thing: 3D 
geometry that’s defined in a computer file.) Coordinates within a model are in 
model space (i.e. relative the model’s origin), and coordinates in a Bunkspeed  
DriveSuite project are in project space (i.e. relative to origin in the center of 
the scene). The separation of model space and project space helps 
Bunkspeed  DriveSuite preserve the correct relative sizes of multiple models 
in the same Bunkspeed  DriveSuite project.

IMPORTING MODELS

Bunkspeed  DriveSuite can import 3D models in many common file formats. 
Most 3D modeling software today can export to at least one of the formats 
that Bunkspeed  DriveSuite can import. (For a complete list of supported 
import formats, see “Import Formats for 3D Models”.) Support for some of 
these 3D formats depends on plugins that you can download for free from 
Bunkspeed’s web site:

http://www.bunkspeed.com

Importing a model is easy:

1. To import a model, select File > Import from the Main Menu. The Import 
Settings dialog appears, so you can locate and load a model.
– Alternative: Select Project > Import Model from the Main Menu.
– Alternative: In the Model Tab of the Palette, RIGHT-CLICK in the 

Model Tree, and select Import from the Context Sensitive menu.

2. The Import Settings dialog (below) may contain format-specific import 
options. If the dialog appears, select the import options you prefer and 
LEFT-CLICK OK to import the model:
– Geometry:

» Apply Auto-Size: If enabled, the importer automatically sizes the 
model to best fit within the open scene.

» Part Grouping: Groups geometry into parts based on your 
choice of layers, materials, and/or divisions in the source model. 
The Automatic option (generally recommended) uses all three to 
produce the most diverse groupings. The Flatten option ignores 
groupings and imports the geometry as a single part.

» Tessellation Quality: Determines the relative accuracy of the 
results when converting a model to polygons. The higher the 
tessellation quality, the more polygons are used to represent 
curved surfaces in the model, and the smoother the results. The 
downside to high quality tessellation is a heavy model with a 
large file size that’s more taxing on your hardware.
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» Advanced Tessellation Settings: Lets you fine-tune exactly 
how models get tessellated (i.e. converted into polygons). 
Experts only.

» Advanced Sewing Settings: Specifying multiple passes ensures 
that parts in models are all connected (i.e. they all share vertices), 
so as to eliminate seams between adjacent materials.

» Design Program Settings: Lets you set the alignment (Vertical 
Axis and Horizontal Axis) and the units of the Importer to match 
how the model is set up in the source software.

– Materials: To ignore materials, uncheck the Import Materials option 
on the tab itself. To import materials, check that option and configure 
the following import parameters:
» Ignore Texture References: ignore all textures associated with 

materials in the source model.
» Auto Search for Missing Textures: look in logical places for 

missing textures referenced by materials in the source model.
» Texture Auto-Search Paths: Lets you specify where  DriveSuite 

looks for textures referenced by materials in the source model.
– Cameras: By default, all cameras in the source file will be imported, if 

possible. To ignore cameras, uncheck the Import Cameras option.

Importing OBJ Files
When exporting the OBJ file from your source software, make sure to choose 
a tessellation that meets your needs. Close-ups in Bunkspeed  DriveSuite 
look best at higher tessellation (i.e. more triangles for smoother surfaces) than 
more distant views. You must determine tessellation inside the 3D modeling 
software you are using to create the model. You can’t change the tessellation 
of a model after it’s been imported into Bunkspeed DriveSuite.

Fine tessellation increases the size of an OBJ file, so ensure that your 
computer has enough RAM and other resources to handle your preferred 
degree of tessellation.

The OBJ file format does not support a full scene graph, but it does maintain 
all material assignments, including textures. When importing an OBJ file and 
its material files, make sure that all associated files stay together in the same 
folder. Upon import of the OBJ file, Bunkspeed  DriveSuite will automatically 
copy the model’s textures into the Textures Library.

All materials inside the OBJ file are converted to material groupings in 
Bunkspeed DriveSuite. Specifically, all parts in your model sharing the same 
material will become a single material group in Bunkspeed DriveSuite. You 
cannot alter imported material groups from within Bunkspeed DriveSuite. 
Hence, you must assign materials in your 3D modeling software before 
exporting to OBJ.

Bunkspeed  DriveSuite interprets imported material files – as well as any 
texture maps, bump maps, or decals that are used in the model. After 
importing the model, Bunkspeed  DriveSuite allows you to edit the resulting 
material parameters in the usual way, or by assigning other materials from the 
Material Library.
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Importing SolidWorks Files
Bunkspeed  DriveSuite allows you to directly import native SolidWorks 2014 
and prior files (SLDPRT and SLDASM).

Bunkspeed  DriveSuite uses the tessellated information stored with the 
SolidWorks part files. In most cases, this tessellation is fine enough for good 
results in Bunkspeed DriveSuite, but close-ups may require finer tessellation. 
Please refer to your SolidWorks documentation for information about refining 
the tessellation of your part file and/or entire assembly. Refining tessellation 
can significantly increase file size, as can importing larger assemblies. Make 
sure that your computer has enough RAM and other resources to handle 
large files. Importing and rendering larger files may affect system 
performance.

When importing a single part file, Bunkspeed  DriveSuite uses the materials 
that were inside SolidWorks in order to determine the material groups. 
Bunkspeed  DriveSuite places identical materials into a single material group. 
Objects with no assigned materials will use a single material group.

When importing an assembly file, Bunkspeed  DriveSuite assigns an 
individual material group to every part in the assembly, as well as any material 
that is contained within the individual parts. Identical parts will be grouped into 
a single material group.

Upon import, Bunkspeed  DriveSuite interprets any materials described in the 
SolidWorks file, including texture and bump maps that have been applied in 
SolidWorks. Bunkspeed  DriveSuite stores all necessary information in a BIF 
(Bunkspeed Interactive Format) file.

Importing Drive Pro/ENGINEER, Pro/E, and CREO Files
Bunkspeed  DriveSuite support a Drive Pro/E plugin which allows you to 
launch your model directly from Drive Pro/E into DriveSuite. You can get the 
plugins for importing these formats on Bunkspeed’s web site.

Importing Rhino Files
Before importing Rhino files (3DM format, version 5 or earlier), make sure that 
your individual parts and material groups are on individual layers in Rhino. 
Bunkspeed  DriveSuite converts individual layers to different material groups. 
In addition, you will need to assign material to all objects by layer.

Importing SketchUp Files
When importing SketchUp files (SKP format, version 8 or prior), Bunkspeed  
DriveSuite takes the geometry and color information, along with all applied 
textures, and brings them into Bunkspeed DriveSuite. All textures are kept in 
a separate folder together with the original SketchUp file in the original 
location.
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Importing IGES Files
When importing IGES files, Bunkspeed  DriveSuite recognizes any layer 
information inside the IGES file. These layers result from layer information in 
the original CAD file, or the assembly structure. Each layer is imported as an 
individual material group. Original materials are not recognized.

To automatically update imported CAD files when the source file changes, be 
sure to select Automatically Re-Import Part when Sources Change from 
Import dialog.

Importing STEP Files
Bunkspeed  DriveSuite recognizes assembly information inside imported 
STEP files. All parts inside the assembly result in individual material groups. 
Original materials are not recognized. 

Importing WIRE Files
 DriveSuite can import WIRE files automatically – provided you have an 
Autodesk Alias product installed from 2008 - 2012.

Importing Autodesk DWG and DXF Files
The importer recognizes 3D information inside imported DWG and DEF files. 
All parts inside the drawing result in individual material groups. Original 
materials are not recognized.

Importing Collada (DAE) Files
The importer recognizes assembly information inside imported Collada (DAE) 
files. All parts inside the assembly result in individual material groups. Original 
materials are not recognized.

Importing ACIS Files
The importer recognizes assembly information inside imported ACIS files. All 
parts inside the assembly result in individual material groups. Original 
materials are not recognized.

Importing Adobe 3D PDF Files
The importer recognizes 3D information inside imported Adobe PDF files. All 
parts inside the assembly result in individual material groups. Original 
materials are not recognized.
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Importing Autodesk Inventor Files
The importer recognizes assembly information inside imported 2012 and 
previous Inventor IPT and IAM files. All parts inside the assembly result in 
individual material groups. Original materials are not recognized. However, 
tessellation control of the import is now available. In order to import Inventor 
files, Autodesk Inventor 2012 (or the free Autodesk Inventor Viewer 2012) 
must be installed and run at least once prior to import.

Inventor files are now supported by a plugin.

Importing Autodesk FBX Files
The importer recognizes model and animation information inside imported 
FBX files. All parts inside the assembly result in individual material groups. 
Original materials are not recognized. The FBX importer now also support 
geometry animation that can be imported, played back, and output.

If you import an FBX file that contains an animation, then the animation shows 
up in Timeline, where you can play it and rendered it out using the animated 
cameras imported from the source FBX file.

Importing SolidEdge Files
The importer recognizes assembly information inside imported SolidEdge 
PAR and ASM files. All parts inside the assembly result in individual material 
groups. Original materials are not recognized.

Importing Dassault 3DXML Files
The importer recognizes assembly information inside imported 3DXML files. 
Among other CAD applications, 3DXML is the best import option from 
Dassault Catia V6 or older. All parts inside the assembly result in individual 
material groups. Original materials are not recognized.

Importing Autodesk 3D Studio Max 3DS Files
The importer recognizes geometry information inside imported 3DS files. All 
parts inside the assembly result in individual material groups. Original 
materials are not recognized.

Live Update from CAD system
When a cad file is imported, it can be monitored for changes via the settings 
you choose in the File > Import menu. Also, you can set a flag at the model or 
part level in the Model/Part Palette that automatically updates parts when the 
original file is updated and saved. If you activate this feature, the application 
will notify you when models / parts get externally updated, and you can either 
accept or ignore the change.
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TRANSFORMING MODELS

There are several ways you can transform (i.e. move, rotate, and/or scale) 3D 
models in the open Bunkspeed  DriveSuite project:

• Numerical Transforms

• Using the Transform Manipulator

All transforms are relative to pivot point of the model. (The pivot point of the 
model is determined by the external modeling software used to create the 
model.) In the drop-down menu of the Transform Manipulator, 

– if you select Absolute Mode, transforms are relative to a copy of the 
world axis at the pivot point of the model;

– if you de-select Absolute Mode, transforms are relative to the 
model’s local axis and pivot point.

Numerical Transforms
Numerical transforms allow precise translation, rotation, and scaling of a 
model. You control numerical transforms with the Model Tree and Transform 
parameters in the Model Tab of the Palette. (The Model Tree lists all the 
models in the open project, and the parts in each model.) 

1. In the Model Tab of the Palette, LEFT-CLICK the name of the target 
model in the Model Tree to select the model. Be sure to select the entire 
model, not just one part or just the root node.
– Alternative: Select the Model Selector in the Toolbar, and then 

DOUBLE-CLICK the target model in the 3D Viewport.

2. In the Transform section of the Model Tab, you can modify the position, 
rotation, and scale of the selected model as follows:
– Position XYZ: changing these values causes the model to move 

along the selected axis (from left to right: X, Y, Z). For example, 
entering “5” in the X-field causes the model to move 5 units along X-
axis of the project’s coordinate system.

– Rotation XYZ: changing these values causes the model to rotate 
around the selected axis (from left to right: X, Y, Z). For example, 
entering “90” in the Y-field causes the model to rotate 90-degrees 
around the Y-axis of the project’s coordinate system.

– Scale XYZ: changing these values unequally distorts the model (i.e. 
entering different values in the (X, Y, Z) fields scales the model by a 
different amount along each axis).

– Scale All: changing this value to something other than “1” causes 
the model to grow or shrink proportionally. For example “2” will double 
the size of the model, and “0.5” will half its size.

For a comparison of numerical and visual transforms, see the table in the next 
section.
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Using the Transform Manipulator
You can transform a model visually with the Transform Manipulator. Visual 
transforms are quick and easy, but not as precise as numerical transforms.

1. Activate the Model Selector Tool in the Toolbar, and select the target 
model in the 3D Viewport. (You can’t transform individual parts separately 
from their parent model.)

2. Activate the Object Manipulation Tool in the Toolbar, and select the Move 
Manipulator to translate the model, or the Scale Manipulator to scale 
the model, or the Pivot Manipulator to rotate the model relative to its root 
node. The Transform Manipulator matching your selection appears in the 
3D Viewport. To use it, follow the instructions in the table below:

Numerical vs. Visual Transforms

Action Numerical Transforms from the 
Model Tab in the Palette

Visual Transforms with the Transform 
Manipulator

Move the model POSITION XYZ: Moves the model along the 
selected axis (X, Y, or Z) by the distance you 
specify.

Select the Move Manipulator. Then 
LEFT-CLICK-HOLD the desired axis and 
drag the mouse to move the model:
• Red Line: Moves along X-axis
• Green Line: Moves along Y-axis
• Blue Line: Moves along Z-axis
• Yellow Box: Free form moves

Rotate the model ROTATION XYZ: Rotates model around the 
selected axis (X, Y, or Z) in degrees.

Select the Move Manipulator. Then 
LEFT-CLICK-HOLD the ring around the 
desired axis, and drag the mouse to rotate 
the model around that axis:
• Red Ring: Rotates around X-axis
• Green Ring: Rotates around Y-axis
• Blue Ring: Rotates around Z-axis

Scale the model SCALE XYZ: Scales the model along each 
axis individually (X, Y, or Z), which distorts 
the model.
SCALE ALL: Scales the model uniformly. 
The units are relative to 1 = current size. For 
example, “2” makes your model twice as 
large as it currently is.

Select the Scale Manipulator. Then 
LEFT-CLICK-HOLD the desired axis and 
drag the mouse to scale the model:
• Red Line: Scale in the X-axis
• Green Line: Scales in the Y-axis
• Blue Line: Scales in the Z-axis
• Yellow Box: Scales uniformly
Copyright © Bunkspeed, Inc. 2002-2014 72



Bunkspeed  Drive Suite User Guide Working with 3D Models Transforming Models
MOVE MANIPULATOR
The same icon slot in the UI provides access to 3 transform tools: the Move, 
Scale, and Pivot Manipulators. The Move Manipulator translates (moves) the 
model.

SCALE MANIPULATOR
The same icon slot in the UI provides access to 3 transform tools: the Move, 
Scale, and Pivot Manipulators. The Scale Manipulator scales the model.

Move the model’s pivot point POSITION XYZ: Moves the pivot point of the 
selected model along the selected axis (X, Y, 
or Z) by the distance you specify.

ROTATION XYZ: Selects the local rotational 
behavior for the selected model around each 
axis (X, Y, or Z) in degrees.

Select the Pivot Manipulator. Then 
LEFT-CLICK-HOLD the desired axis and 
drag the mouse to move the model:
• Red Line: Moves along X-axis
• Green Line: Moves along Y-axis
• Blue Line: Moves along Z-axis
• Yellow Box: Free form moves

Select the Pivot Manipulator. Then 
LEFT-CLICK-HOLD the ring around the 
desired axis, and drag the mouse to rotate 
the model around that axis:
• Red Ring: Rotates around X-axis
• Green Ring: Rotates around Y-axis
• Blue Ring: Rotates around Z-axis

Set the model on the ground SNAP TO GROUND: Moves the model in the 
vertical axis, until the model’s origin is 
vertically aligned with the world origin.

n/a

Reset all transforms to their 
values when you last saved 
the project.

RESET: Resets all transforms made since 
you last saved the project.

n/a

Rotate model 90 degrees ROTATE: Rotates model exactly 90 degrees 
around the selected axis (X+90, Y+90, 
Z+90)

Move: Hold the Shift-Key while dragging a 
ring to rotate the model in 15-degree 
increments.

Flip the model FLIP: Mirror the model across the selected 
axis (X, Y, Z)

n/a

Attach one model to another n/a Move: RIGHT-CLICK-HOLD the Yellow Box 
and drag the mouse to move the selected 
model onto another model. The pivot points 
of the two models will stick together.
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PIVOT MANIPULATOR
The same icon slot in the UI provides access to 3 transform tools: the Move, 
Scale, and Pivot Manipulators. The Pivot Manipulator rotates the model 
relative to its root node.

ADDING PHYSICS TO MODELS

Dynamic physics can be applied to all models. Vehicles models that have 
properly set up joints for wheels and brake calipers support vehicular physics, 
so you can drive them around.

Assigning Physics to Models
When you select a model, its Physics parameters appear in the Object 
Parameters section of the Model Tab in the Palette. Use these parameters to 
assign physics to selected models. If you’re setting up a vehicle for driving, 
then set the Physics Type to Car.

Once you have assigned physics to models, you can start and stop realtime 
physics simulation by toggling the Power button in the animation Timeline. 
The Timeline also provides you with the means to record and play back 
dynamic interactions between models and the ground.

Building Wheels and Calipers for Vehicles
In this section, you will learn how to build joints for the wheels and brake 
calipers of an existing car model with 4 wheels. Building these specialized 
joints differs from building normal joints. Correctly building joints for wheels 
and calipers is critical to animating and driving cars in general.

LOAD THE CAR MODEL

1. Open or import a car model with parts for wheels and their components, 
and dependent parts for brake calipers. 

ORIENT THE CAR
In order to correctly apply joints to wheels and calipers, the car must be 
oriented in a very specific way. You cannot use the Move Manipulator to do 
this orientation. To establish the proper location and rotation of the model’s 
node states, you need to use the Vehicle Setup 

2. Select the car model.

3. In the Vehicle Setup section of the Model Tab, select the Vehicle Facing 
axis to match the direction the front of the vehicle is facing towards.
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– NOTE: You can see the axes in the Viewport by displaying the world 
origin (i.e. right-click in the 3D View and toggle on World Origin from 
the drop-down menu). Alternately, you can use the Move Manipulator 
as a visual reference, but do not use the Manipulator to move the car!

SELECT THE WHEELS
Car models typically have many parts. It would be tricky to surgically select 
each part of the wheels and calipers directly. To simplify this task, first select 
and hide all the parts that are not related to the wheels and calipers. Think of 
it as an inverse selection:

4. Enter Camera Mode.

5. In the Camera Tool Panel, click the Side button to get a side view of the 
car model, which happens to be located at the World Origin. Then zoom 
in so the side view of the car fills most of the 3D View.

6. Switch to Parts Mode (a sub-mode of Model Set), and activate the Parts 
Selector Tool.

7. Click-hold and drag a selection box around the center of the car, from 
above the roof to below the undercarriage. Be very careful to keep the 
box narrow enough to avoid selecting any part in the wheels or calipers.

8. Press Ctrl-H to hide the selected parts.

9. Repeat the previous two steps to select and hide all other parts, except 
for the parts composing the wheels and calipers. When you’re done, the 
only visible parts should be in the wheels and calipers.

10. Select every part in the wheels – including brake rotors, rims, nuts, etc – 
except the calipers. The calipers typically rotate with the wheels when the 
steering is turned, but do not spin with the wheels.

BUILD WHEELS
This subsection tells you how to build joints for wheels.

11. With the wheels selected, click Create Wheels from Selected Parts in 
the Vehicle Setup section of the Model / Parts Palette. This builds the 
joints for the wheels.

SELECT AND BUILD BRAKE CALIPERS
Brake calipers and wheels both need to be animated, but not in quite the 
same way: Calipers turn left and right with the front wheels, but calipers do 
not spin with the wheels. Here’s how to build joints for calipers:

12. Middle-click anywhere in the 3D View to de-select all.

13. Enter Parts Mode (a sub-mode of Model Set), and take a look at the 
thumbnails in the Parts Palette. Notice that the thumbnails for hidden 
parts are greyed out. 

14. To select the calipers and their logos, hold the Ctrl-Key and click on each 
and every thumbnail for the caliper parts in the Model / Parts Palette:
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15. With the calipers and their logos selected, click Create Calipers from 
Selected Parts in the Model / Parts Palette. This action builds joints for 
the calipers.

16. Right-click in the 3D View and select Show All from the drop-down menu. 
The entire car should become visible again.

17. Save your project.

DRIVING VEHICLES
Once you have built the wheel joints and brake caliper joints, and you have 
set the Physics Type to Car, you should be able to use the Wheel Turn 
parameter to turn the wheels and calipers with them.

You can drive vehicles with an Xbox controller. Or you can use some of the 
Physics parameters (in the Physics section of the Model Tab in the Palette) to 
activate one of the provided Driving Behaviors, as follows:

• Driving Behavior = Straight: Then, in Animation Timeline, click ON the 
Physics button in the upper right. The car will drive itself forever. You can 
influence the driving physics it in real-time by messing with the Physics 
parameters in the Model Palette. You can manually move your camera as 
the vehicle drives, or set the camera (in the Camera Palette) to “follow” 
the vehicle’s model.

• Driving Behavior = Turn: The car drives itself forever in a circle.

• Driving Behavior = Path gives you 4 waypoints. You can move these 
waypoints like any object (e.g. with Move Tool), and add additional 
waypoints if desired, to make your own driving course. Uses AI and 
realistic physics.

You can optionally record physics-based driving by activating the Record 
button in the Timeline. You can render out animations in any render mode.

HIDING / SHOWING MODELS AND PARTS

If your source model has parts defined in it, then Bunkspeed  DriveSuite will 
preserve these parts when you import the model. In  DriveSuite, you can 
selectively hide and show individual parts on the models in your project. 
Hiding parts selectively is very useful when applying materials to layered 
objects and isolating parts for individual renderings. Here’s how:

• To show / hide models or parts: In the Model Tab in the Palette, select the 
target model or part in the Model Tree, and toggle the Hide check box. 
Alternatives using the context-sensitive menu (see figure):
– To hide a model, use the Model Selection Tool to RIGHT-CLICK the 

target model in the 3D Viewport, and then select Hide Model from 
the context sensitive menu.

– To show all models and parts in the loaded project, RIGHT-CLICK 
anywhere in the 3D Viewport and select Show Everything from the 
context sensitive menu.

– To show selected parts only, RIGHT-CLICK anywhere in the 3D 
Viewport and select Show Parts from the context sensitive menu.
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MORE ABOUT PARTS

When a material with a texture is mapped to a specific part, some of the 
mapping properties are inherited from the definition of the material. You can 
further refine the mapping of the material onto a part you have actively 
selected in a model. You can also modify the normals in the part, and control 
Symmetry. Here’s how:

Symmetry
Symmetry mirrors the selected part across the specified axis. This is useful for 
symmetric objects because you can import just half the model (have the 
number of triangles) and instance their symmetric data.
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Part/Normals Control
Part and normals control reconstructs normals. This process often solves 
flipped normals as well as badly formed normals common in Sketchup files 
and lesser quality data. 

• Part/Normals Control: 
– Faceted: Rebuilds normals with hard edges between the polygons

» Angle: Lets you choose how sharp of an edge to maintain
– Smooth: Rebuilds the normals with a blended joint between polygons, 

yielding a softer surface description
– Rebuild Normals: Executes the rebuild process.
– Repair Normals: Aligns normals without rebuilding the texture verts.
– Split Part: See Splitting Models and Parts, next.
– Extract Part: See Splitting Models and Parts, next.

Splitting Models and Parts
A “part” is a grouping of one or more pieces in a model. Each piece is also a 
part which can be composed of still smaller pieces, etc. Pieces don’t have to 
be physically next to each other to be grouped together.

Here’s how you split parts into smaller pieces:

1. Right-click a part in the open scene using the Selection Tool. (Alternately, 
In the Models Tab of the Palette, click the thumbnail of the target part to 
select it.)

2. In the right-click menu, select Extract Part. The Part Splitting dialog 
appears. (Alternately, you can select Extract Part from the Model Tab.)

3. In the Part Splitting dialog, adjust the tolerance of part splitting via the 
Facet Angle Tolerance setting and the slider next to it. To preview the 
tolerance settings, left-click the target part and continue the adjustments. 

4. When ready to execute the split, right-click the target part again.
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Texture Mapping on Parts
The Model Tab in the Palette includes the following Texture Mapping 
parameters, which appear when you actively select a part in the open model:

• Mode: Determines how the selected texture is projected onto 3D 
surfaces. Each of the following types of texture mapping includes its own 
parameters for controlling the mapping. (For illustrations, see Texture 
Mapping on Parts using the Texture Manipulator.)
– UV: If your object does not have UV coordinates, its textures may not 

show up initially. Fix by changing projection type.
– Box: Uses a “box” projection.
– Planar (X, Y, Z): Projects a flat texture plane in the X, Y or Z-axis. To 

determine the direction, turn on the coordinate system in the Image 
Tab, or use [SHIFT] + C. If the surface you would like to map to is at 
an angle, you may want to rotate the model so it aligns with the 
direction of the projection. After mapping, move the object back to its 
original position, and the mapping will move with it.

– Spherical: Uses a spherical projection with Y being the up-axis. If 
your object requires spherical mapping in a different direction, rotate 
the object to align with the projection direction. Move the object back 
to its original position after mapping. 

– Radial: Projects the texture as a circular plane, like a circular version 
of Planar.

– Cylindrical: Projects the texture as a cylinder standing up (y-
direction) for mapping. If your object requires cylindrical mapping in 
any other direction, rotate the object to align with the projection 
direction. Move the object back to its original position after mapping.

– Perspective: Maps the texture from the current camera angle so that 
it maps perfectly, but ONLY from the current camera.

• Manipulate Texture: Lets you visually shift, scale, and rotate the selected 
texture on an applied surface using the Texture Manipulator, which is a 
type of Transform Manipulator that acts on textures in materials. For 
details, see Texture Mapping on Parts using the Texture Manipulator.

• Fit to Part: Sizes the texture projection to the bounding box of the 
selected part. This option typically yields the best quick fit, and gives you 
a good starting point to continue editing the placement of the texture.

• Set to World Scale: Sets the texture scale to world coordinates so that 
when that particular texture is applied to multiple parts and each part is 
set to World Scale, then the texture pattern becomes a consistent size on 
each on of those parts. It will also update on each part when the texture 
properties such as a tiling, repeat and rotation is changed.

• Transform: Lets you numerically modify the texture mapping on the 
selected part. The alternative is Texture Mapping on Parts using the 
Texture Manipulator, as discussed in Manipulate Texture above.
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TEXTURE MAPPING ON PARTS USING THE TEXTURE MANIPULATOR
The Texture Manipulator modifies the 3D projection of a texture in a material, 
prior to the texture being converted to (U, V) coordinates on the surface of the 
part the material is applied to. This approach is quite different than using 
Texture Parameters such as Tile, Shift, and Rotation to adjust texture 
mapping, because the latter parameters act in (U, V) space after the 
projection has been applied to the surface of the target part.

The Texture Manipulator functions much like the Transform Manipulator. The 
obvious difference is that the Texture Manipulator operates on textures in 
materials, and the Transform Manipulator operates on models.

Another key difference is that the Texture Manipulator combines the Move 
and Scale Transform Manipulator into a single control. Translation and 
rotation operate the same for both controls, but the scale operates differently 
on the Texture Manipulator control.

The following instructions apply only to parts that have mapped materials 
using textures:

1. Enable the Texture Manipulator, which you can do in 2 ways:
– Use the Selector Tool in Material Mode to select a part in a model. It’s 

parameters will then appear in the Material Tab of the Palette. Then, 
under Texture Mapping, select the Manipulate Texture button.

– In the Toolbar: If the Selector Tool is in Material Mode, activating the 
Move Transform Tool displays the Texture Manipulator.

2. To scale with the Texture Manipulator, simply LEFT-CLICK-HOLD one of 
the boxes at the corners of the manipulator, and drag the mouse.

3. To translate and rotate with the Texture Manipulator, follow the 
instructions for Using the Transform Manipulator on a part instead of 
the model itself – bearing in mind that translation and rotation will affect 
the texture projection.
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Also of note are minor changes to the Texture Manipulator depending on the 
projection mode you are using. Here are all variations (note that UV projection 
mode does not have a corresponding texture manipulator, but all other 3D 
projection modes do):

Box Cylinder Sphere

Planar X Planar Z Radial

DELETING MODELS AND PARTS

You can delete individual parts from a 3D model, or delete the entire model. 
The part or model is not permanently deleted until you save the Bunkspeed  
DriveSuite project.

• To delete a model: In the Model Tree of the Model Tab in the Palette, 
RIGHT-CLICK the name of the target model, and select Delete from the 
context sensitive menu.
– Alternative: Using the Model Selector in the Toolbar, select the target 

model in the 3D Viewport, and press the DELETE-KEY.

• To delete a part in a model: In the Model Tree of the Model Tab in the 
Palette, RIGHT-CLICK the name of the part, and select Delete from the 
context sensitive menu.
– Alternative: Using the Part Selector in the Toolbar, select the target 

part in the 3D Viewport, and press the DELETE-KEY.
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Chapter 5: Working with Materials

Bunkspeed  DriveSuite comes with a library of pre-defined materials that you 
can apply to 3D models in your Bunkspeed  DriveSuite projects. You can also 
create new materials quite easily. This chapter describes how to work with 
materials.

For details on the types of materials that come with Bunkspeed DriveSuite, 
and the properties of each type, see “Types of Materials in Bunkspeed 
DriveSuite” on page VII.

DISPLAY THE MATERIAL LIBRARY

To display the Material Library (shown to the left), select the Library Tab in 
the Palette, and then select Materials from the drop-down menu near the top 
of the Library Tab.

APPLY MATERIALS

You can add an existing material to the open project in two ways: apply a 
material in the Material Library to a model; and load a material from a model 
into the Material Tab (i.e. into the project). Once a material is part of the open 
project, you can then Apply Materials to Parts in Models.

• A “part” is a subset of a model. A complex car model could have 
thousands of parts, for example: Each of the 4 wheels could be a 
separate part, and each wheel part could be composed of smaller parts 
for the metal rim, rubber tire, lock nuts, and brake rotors.

• You cannot define parts in Bunkspeed DriveSuite. Parts are defined in the 
3D modeling software used to create the original model. When you import 
a model with parts into Bunkspeed DriveSuite, the parts will be preserved.

• A material in the open project is totally independent from the materials in 
the Material Library:
– The materials in the open project are saved in the BIF file with the 

rest of the assets in the project (e.g. models, HDR images, 
backplates, cameras, etc.)

– The materials in the Material Library are the files in the Bunkspeed 
Content \ Materials folder, by default.
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• When you apply XYZ material in the Material Library to a model / part in 
the open project,  DriveSuite adds the XYZ material to the project. If you 
then edit the XYZ material in the project, via the parameters in the 
Material Tab of the Palette, then the copy of the material in the project will 
be affected, but the source material in the Material Library will be 
unaffected. The reason is that materials in the project and those in the 
Material Library are totally independent of each other (even if they have 
the same names and parameter values).

• When you open a project containing materials that are not in your Material 
Library, then the new materials will appear in the Material Tab of the 
Palette. To add such a material to your Material Library, simply select the 
target material in the Material Tab, and LEFT-CLICK Save Material To 
Library.

Apply Materials to Parts in Models
The process in this case varies slightly depending on whether your source the 
material from the Material Library or the materials already in the open project, 
as explained below.

USE A MATERIAL IN THE MATERIAL LIBRARY
To apply a material in the Material Library to a part of a 3D model, do the 
following:

1. Display The Material Library.

2. DRAG-AND-DROP the desired material from the Material Library onto the 
target part of the 3D model.

USE A MATERIAL IN THE OPEN PROJECT
To apply a material in that’s already in the open project to a part on a model, 
do the following:

1. LEFT-CLICK the Material Tab in the Palette to activate Material Mode and 
access a list of materials in the open project.

2. DRAG-AND-DROP the desired material from the Material Tab (not the 
Material Library in the Library Tab) onto the target part of the 3D model.
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CREATING, EDITING, AND SHARING MATERIALS

Bunkspeed’s materials are fundamentally different than shaders found in 
traditional rendering applications. All the materials in Bunkspeed  DriveSuite 
are scientifically accurate. It therefore requires far less guesswork to create or 
edit a Bunkspeed  DriveSuite material to have the properties you’re after.

When you create or modify materials, the changes are saved in the BIF file for 
the open project, and the new or modified materials are listed in the Material 
Tab of the Palette. Creating or editing a material in the Material Tab does not 
add the material to the Material Library. To add such a new or modified 
material to your Material Library, simply select the target material in the 
Material Tab, and LEFT-CLICK the Save Material To Library button.

Create and Edit Materials
Creating a new material, and editing an existing material, are nearly identical 
procedures:

1. To create a new material, RIGHT-CLICK in the Material Tree of the 
Material Tab in the Palette, and select New Material from the context 
sensitive menu. 

1. Or, to edit an existing material, LEFT-CLICK the desired material in the 
Material Tree to select the material, and then change the values of its 
parameters.

Note: If you first apply the new or modified material to a model in the open 
scene, then you can more clearly see the visual effects of changes to the 
material’s parameters. To do so, DRAG-AND-DROP the target material 
from the Material Tab to a part in a model in the open project.

2. In the Material Tab of the Palette, ensure that the target material is 
selected, and then change the Material Type parameter, if necessary, by 
selecting the target type from the drop-down menu.
– Each type of material has unique parameters. You can change the 

values of these parameters, but you cannot change which 
parameters are available except by switching to a different type. 
Hence, you should first decide upon the target type of the new or 
edited material before changing any of its parameters.

– For details on the types of materials that Bunkspeed  DriveSuite 
supports, and the parameters of each type, see “Types of Materials 
in Bunkspeed DriveSuite” on page VII.

3. In the Material Tab, you can edit the values of the Material Parameters for 
the selected material, as desired.

4. Also in the Material Tab, you can optionally assign textures to your 
materials, as described in the next section.

5. Once you finish editing a material, you can optionally add it to the Material 
Library, as follows:
i. Select the target material in the Material Tab of the Palette, and LEFT-

CLICK the Save Material To Library button.
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Regardless of whether or not the material originated in the Material Library, 
saving it from the Material Tab to the Material Library adds the modified 
material to the Library as though it were a totally new material.

Add and Edit Textures in Materials
You can optionally use almost any 2D image as a texture that can be added to 
a material. When a material with textures is applied to a part of a model,  
DriveSuite maps the textures on the part according to the properties of the 
textures. Here’s how:

1. In the Material Tab, select the target material in the Material Tree.

2. LEFT-CLICK the Color, Specular, Alpha, or Bump channels in the Material 
Tab to display the Import Textures dialog. (See the figure to the left.)
– ALTERNATIVE: Drag-and-Drop a 2D image from your desktop, email, 

or similar source, to the target Part of a model in the open scene. 
Then select which channel to apply the texture to (e.g. Color, etc).

– With Color textures, non-transparent materials can use a 2D texture 
instead of a base color. However, Some types of materials, such as 
Emissive, multiply the base color by the Color texture RGB values.

– If you are adding an Alpha texture with transparency, Bunkspeed  
DriveSuite uses the transparency channel in the Color texture only.

3. In the Import Texture dialog, locate and select the target texture.
– Note: You can use any 2D image in a supported format such as JPEG 

or TIFF, among others. However, if your texture contains 
transparency, you must use a format such as PNG that supports an 
alpha channel.

– For a list of supported texture formats, see “Import Formats for 
Backplates and Textures” on page VI.

4. After a texture has been added to a material, you can display most of its 
parameters in the Material Tab by selecting the icon of the material in the 
Material Tree; or by using the Material Selector Tool to select a part that 
the material has been applied to. 
– Note: You can control how the texture is applied to a specific part in a 

model by selecting that part. For instructions, see “Texture Mapping 
on Parts” on page 79.

5. In the Material Tab, when you select a texture in a material, you an edit its 
parameters as discussed in Material Tab.

MAPPING TEXTURES
If you select an applied material on a part in a model, and the material 
includes textures, then you can customize its texture mapping in these ways:

– Visually with the Texture Manipulator, as explained in Texture 
Mapping on Parts using the Texture Manipulator;

– Numerically using basic UV mapping, as explained in “Texture 
Parameters” on page 43;

– Numerically using more advanced types of mapping, as discussed in 
“Texture Mapping on Parts” on page 79.
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Share Your Materials
It’s easy to share your materials with others. Bunkspeed  DriveSuite saves the 
materials in your Material Library in BMF files. These BMF files are located in 
the Materials Library, which is contained in the Bunkspeed Content \ Materials 
folder by default.

1. To share materials with others, just give them copies of the BMF files in 
your Material Library. BMF files can be emailed.

When the recipients save your BMF file into their local Material Library folder, 
they will be ready to use your materials in their next Bunkspeed  DriveSuite 
session.

DECALING

Decals are materials with a texture that includes a transparency channel, so it 
shows through whatever is under it. Decals are commonly used to put logos 
on top of other materials, for example.

Creating Decals
The texture that you load for a decal should use a transparency channel to 
define the areas in the decal that should be transparent:

1. To create a decal, right-click a new blank material the tree of the Material 
Tab, and select New Decal from the context-sensitive menu (see figure). 

2. In the file browser that appears, locate and load a decal texture.
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Editing Decals
To edit the properties of a loaded decal, select the decal icon in the tree of the 
Material Tab (see figure), and tune its properties:

• Decal Name lets you rename the decal if you wish. 

• Multiple Part Decal allows the decal to span multiple parts of the model.

• Detached Decal removes the association of the decal from all parts, and 
lets you move it by itself.

• Decal Depth defines how deep beyond the surface the decal penetrates.

• Show Decal Texture toggles whether the image represented on the 
decal is shown or overwritten by white to use as a stencil.

• Use Brightness as Opacity causes any dark portions of the decal to be 
transparent. The closer to black the pixels, the more transparent that area 
of the decal becomes.

• Decal Width lets you determine the physical width of the Decal in meters.

• Decal Height lets you determine the physical height of the Decal in 
meters.

• Project from Current Ortho Camera lets you project the decal from the 
active camera, provided the active camera is an Orthographic camera.
Copyright © Bunkspeed, Inc. 2002-2014 87



Bunkspeed  Drive Suite User Guide Working with Scenes Decaling
Chapter 6: Working with Scenes

In Bunkspeed  DriveSuite, you use High Dynamic Range Images (HDR) as 
the light source for your projects. How? Bunkspeed  DriveSuite maps an HDR 
image of your choice onto a spherical environment that envelops your models 
like a giant bubble. The HDR image thereby radiates light into the scene 
according to the RGB values of each and every pixel in the image. This 
technique closely simulates real world lighting, even when wide contrast 
ranges are called for.

When you right-click in the tree near the top of the Scene Tab, options appear 
for loading new HDR images, lights, and backplates.

For details, see the following sections:

• Create and Edit HDR Environment Images

• Create, Move, and Edit Custom Lights

• Create and Edit Backplate Images
Copyright © Bunkspeed, Inc. 2002-2014 88



Bunkspeed  Drive Suite User Guide Working with Scenes Create and Edit HDR Environment Images
CREATE AND EDIT HDR ENVIRONMENT IMAGES

A single High Dynamic Range Image (HDR) provides realistic lighting for 
projects created in Bunkspeed  DriveSuite. For instructions, see Load a HDR 
Environment Image, next.

Load a HDR Environment Image 
Loading a new HDR image into an environment replaces the old HDR image. 
Once loading completes, you will see the lighting in your scene change to use 
the light from the new HDR image.

1. Select Project > New HDR Environment from the Main Menu. 

2. In the Open Environment dialog, navigate to the desired HDR file and 
open it. The HDR image loads into the environment of your scene.

• Alternative: To apply a previously loaded HDR image to your project, 
DOUBLE-LEFT-CLICK the icon of the desired image in the Scenes Tab.

• Alternative: In the Scenes Tab of the Palette, RIGHT-CLICK within the 
Environment Tree near the top (which lists the environments saved with 
your project), and select New HDR Environment.

Tune HDR Environment Images
Upon import, Bunkspeed  DriveSuite preserves the brightness and gamma 
settings in the source HDR file. After import, you can change these settings, 
as well as make other adjustments to the environment, in the Environments 
Tab of the Palette.

To display all the tools, left-click the Tools button in the Quick Start bar, or left-
click the expansion bar on the far right edge of the Bunkspeed  DriveSuite 
Window. Then select the Scenes Tab to display Environment Tools.

SHOW / HIDE THE ENVIRONMENT
To toggle the visibility of the environment image, LEFT-CLICK the Show 
Environment Image check box in the Scenes Tab of the Palette when the 
target Environment icon is selected therein. Notes:

• Even when hiding an HDR environment image from direct view, the image 
continues to radiate light into the project as well as reflect visibly off shiny 
surfaces.

• When an environment image is hidden, and a backplate (if any) is also 
hidden, the color of the background is defined by the Background Color 
parameter in the Scenes Tab.

TRANSFORM THE ENVIRONMENT
By default, the HDR image used in a Bunkspeed  DriveSuite environment is 
mapped onto a sphere with a radius of 25 meters centered at the world origin. 
The sphere envelops your entire project with HDR light that very closely 
simulates the light in real world environments.
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You can rotate, scale, and offset the environmental sphere, relative to the 
world origin. See the subsections below for details.

Rotate the Environment
To rotate the environment, and thereby change the direction of light radiated 
by the environment image, edit the Rotation parameter in the Scenes Tab of 
the Palette. Rotation is in degrees.

Scale the Environment
To make the environmental sphere whatever radius you wish, within reason, 
change the Size (meters) parameter in the Scenes Tab of the Palette.

Offset the Environment
To vertically offset the environment image relative to the world origin, edit the 
Height (meters) parameter in the Scenes Tab.

ADJUST BRIGHTNESS AND GAMMA
You can adjust the brightness and gamma of the light emitted by the 
environment image in your project. For details, see the sections below.

Environmental Brightness and Gamma
Modifying the brightness of the environment image changes the exposure of 
the image. (Note: Bunkspeed  DriveSuite changes brightness and contrast in 
real-time. The source file of the environment image is not altered.)

Changing the exposure of the environment image alters the luminance (i.e. 
intensity) of the light the image radiates into your open project. (Note: 
Everything except backplates images are affected by the light emitted from 
the applied HDR environment image.)

Modifying the gamma of an environment image changes contrast indirectly. 
Altering gamma also change brightness, but in a very different way than the 
Brightness parameter. Although gamma is not the same as contrast, you can 
use gamma to adjust contrast, while using brightness to adjust luminance. 
Used together, these two controls enable you to fine tune the combined 
brightness and contrast of the lighting in your project.

Because HDR images have so much data (32-bits per channel of RGB data), 
they have a very wide contrast range. Hence, small changes to the brightness 
and contrast of an HDR image usually produces high quality results.

1. Display the Environments Tab in the Palette.

2. In the Environments Tab, change the Brightness parameter and observe 
the results in the Realtime View. Higher values increase brightness; lower 
values decrease it.

3. Change Gamma in the Environments Tab, and observe the results in the 
Realtime View. Higher values decrease contrast and increase brightness; 
lower values increase contrast and decrease brightness.
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DISPLAY SHADOWS
Bunkspeed  DriveSuite can calculate the shadows that each 3D model casts 
on itself, on other models, and on the ground. Enabling shadows can impact 
performance due to the increased number of calculations required.

1. To enable or disable ground shadows, toggle on the Ground Shadow 
parameter in the Scenes Tab of the Palette.

2. Optionally use the Shadow Intensity Slider to darken or lighten the 
environment ground shadow.

DISPLAY CAUSTICS AND SHADOWS ON GROUND PLANE
To display caustics and shadows from physical light sources on the artificial 
ground plane, max out the Ground Reflection and Ground Glossiness values. 

FLATTEN THE GROUND
HDR images are spherical by default, with the equator corresponding to the 
imaginary level of the ground. Flattening the ground converts the environment 
sphere to a half-sphere. The image is re-mapped to the resulting half-sphere, 
and the bottom becomes a visible ground.

• To flatten the ground of an environmental sphere, toggle on the Flatten 
Ground parameter in the Environments Tab.

Create and Edit HDRI Environments in HDR Light Studio
Create an HDRI in HDR Light studio by selecting the New HDRLS 
Environment button. This will launch HDR Light Studio. Any edits you then 
perform inside HDR Light Studio will update the lighting in your Bunkspeed 
application in realtime.

Or you can edit an existing HDRI by selecting Convert to HDR Light Studio. 
This will launch the selected HDRI inside HDR Light Studio. Any edits made to 
the environment in HDR Light Studio will update in realtime.

• Hide UI: Closes the HDR Light Studio UI.

• Finish: Finalizes any edits made to the environment in HDR Light Studio

• Render: Generates the full resolution composite of the environment when 
edits are complete
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• Save: Saves the current edits as an HDR Light Studio project.

• Revert: Rolls back changes applied in HDR Light Studio to the original 
state of the environment.

CREATE, MOVE, AND EDIT CUSTOM LIGHTS

You can supplement the HDR lighting in your scene by creating and tuning 
individual lights. Here’s how:

1. In the Project Menu, select New Light to create a new light in your scene.
– Alternative: Right-click in the tree near the top of the Scene Tab, and 

select New Light from the context-sensitive menu.

2. In the Toolbar, select the Move Manipulator Tool. To select the light, click 
on either the icon for the light source or its look-at point in the scene. 
(Alternatively, you can select the light’s icon in the Scene Tab.) The 
properties of the selected light appear in the Scene Tab.

3. Optionally edit the Light Parameters in the Scene Tab.

4. Using the Move Manipulator, you can move the selected light in the open 
scene, as follows:
– Click-hold and drag the blue ring by +22.5 degrees to rotate the light 

around the Z-axis.
– Click-hold and drag the green ring to rotate the light +90 degrees 

around the Y-axis (green arrow).
– Click-hold and drag the grey arrow to bring the light closer to its look-

at point, until the light icon is within view.

You can optionally create multiple lights by repeating the above procedure. 
Note that multiple lights can substantially reduce real-time performance and 
add to rendering times.

Note that you can set the ground shadow to form from spot or point lights only 
if a ground plane is present.

CREATE AND EDIT BACKPLATE IMAGES

A backplate allows you to load a high resolution 2D image in the background 
of your Bunkspeed  DriveSuite project. Once loaded, the backplate image 
always remains in the background no matter where you move the camera.

3D models in the scene retain the lighting specified by a HDR environment 
image, without influence from the backplate image. Backplate images do not 
emit light in your scene, do not cast shadows, and do not reflect in shiny 
surfaces. They just look great in your background.

Loading Backplate Images
To load a new backplate image into your Bunkspeed  DriveSuite project, or 
replace the current backplate image, do the following:
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1. Select Project > New Backplate from the Main Menu. The Open 
Background Plate dialog appears. 

2. In the Open Background Plate dialog, navigate to the image you wish to 
import and open it. The image loads into the background of the open 
project, and stays in the background regardless of camera movements.
– Alternative 1: Place your background images into the Plates Library. 

Then DOUBLE-LEFT-CLICK the desired image in the Plates Library 
to apply the image to your open project.

– Alternative 2: In the Scenes Tab of the Palette, RIGHT-CLICK 
anywhere in the Scene Tree near the top, and select New Backplate.

– Note: The Auto-Fit Camera parameter in the Scenes Tab 
automatically fits the camera to the backplate, while matching the 
aspect ratio of the active camera to that of the backplate.

Loading a new image into the background of your scene replaces the old 
backplate image, if any. 

If you edit the source image for the loaded backplate using software such as 
Photoshop, the backplate in your Bunkspeed scene will automatically update 
– provided that you’ve turned on Auto-Update in the Scenes Tab of the 
Palette.

Backplate images do not affect the lighting in your scene. To show or hide a 
loaded backplate image, first select it in the Scenes Tree in the Scenes Tab of 
the Palette. When its parameters appear, toggle the Visible parameter to 
show or hide the backplate image.

For details on tuning backplate images, see “Backplate Parameters” on 
page 48.
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CREATE A NEW SUN AND SKY ENVIRONMENT

The application can simulate the lighting at a specific location and time of day 
on the earth. The resulting Sun and Sky Environment is different in some 
ways than an HDR image, although both radiate full HDR light. 

1. Select Project > New Sun and Sky Environment from the Main Menu. 
The parameters unique to Sun and Sky Environments appears in the 
Environments Tab of the Palette.
– Alternative: In the Scenes Tab of the Palette, RIGHT-CLICK in the 

Environment Tree near the top (which lists the environments saved 
with your project), and select New Sun and Sky Environment.

2. Fill in the Parameters for Sun and Sky Environments, described next.

Parameters for Sun and Sky Environments
When creating or editing a Sun and Sky Environment, you determine its 
properties by setting the values of the following parameters:

• Show Environment Image: Toggles visibility of the environment image 
loaded in the 3D Viewport. Even when invisible, the loaded environment 
image still emits light into the scene.

LOCATION SETTINGS

• Location: Informational (read-only) latitude and longitude of the geo-
location being simulated.

• Date and Time: Informational (read-only) month and time of day at the 
geo-location being simulated.

• Set Location and Time: Click this button to change the location and/or 
the date and time being simulated. For details, see Set Location and Time 
(below).

SUN/SKY SETTINGS

• Haze: Set the amount of haze in the simulated air.

• Red-Blue Shift: Set the degree or red or blue shifting in the white 
balance of the simulated light, relative to neutral sunlight (5500 Kelvin).

• Saturation: Set the saturation of the color shift (if any) of simulated light.

• Horizon Blur: Set the degree to which the horizon blurs out, to simulate 
the visibility limits.

• Sun Intensity: Set the intensity of the simulated sunlight.

• Sun Size: Set the size of the solar disk in the sky.

• Sun Glow: Set the size and diffusion of the glow around the sun’s disk.
Copyright © Bunkspeed, Inc. 2002-2014 94



Bunkspeed  Drive Suite User Guide Working with Scenes Create a New Sun and Sky Environment
• Ground Color: Set the color of the ground plane.

• Night Color: Set the color of the night (ambient) color.

BACKGROUND SETTINGS

• Flatten Ground: When enabled, the environment becomes a half-
sphere. When disabled, the environment becomes a full sphere.

• Background Color: Determines the background color of the 3D Viewport 
outside the environment sphere. LEFT-CLICK the color to display a 
standard color picker.

• Brightness: Adjusts the overall brightness of the selected environment 
image.

• Size: Determines the radius, in meters, of the environment sphere.

• Rotation: Rotates the loaded environment image on the environment 
sphere.

• Ground Reflection: Adjust the visibility of the ground reflection where 0 
is off and 1 is full reflection.

• Ground Glossiness: Adjusts the roughness of the ground reflection 
where 0 is perfectly crisp and 1 is fully rough.

• Ground Shadow: Toggles the projection of shadows on the ground in 
both Performance and Raytrace Modes.

• Show Grid: Toggles visibility of a grid in the XZ-plane. (This option is 
available only when Raytracing is off.)

Set Location and Time
When you click the Set Location and Time button, a dialog appears with the 
following parameters you can edit:

• Sun and earth graphic:
– Click one of the suns to set the Sun Incline value quickly, or enter it 

precisely by changing the Time value (since time of day is the biggest 
factor in determining the incline of the sun at a fixed geo-location). 
The sun on the far right is 0 degrees, then 45, then 90 over north 
pole, then 135, then 180.

– Click Latitude and Longitude lines to set their approximate values 
quickly. Or enter precise values in the fields below.

• Month: Set the general time of year being simulated.

• Time: The time of day being simulated on a 24-hour clock. In combination 
with Month, Latitude, and Longitude, the Time value determines the Sun 
Incline (below). You can change Time numerically or by dragging the 
slider below it.

• Set Time to Now: Sets the Month and Time values to your system time.
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• Latitude: The latitude of the location being simulated.

• Longitude: The longitude of the location being simulated.

• Sun Incline: Use the slider below Time to set the angle of incoming 
sunlight, and adjust the Time of day accordingly.
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Chapter 7: Working with Animations

In the most general sense, animation is visual change over time. 

In most animation software such as Bunkspeed DriveSuite, you create a 
simple motion animation by recording the desired starting position of an object 
at a specific time, and then recording the desired ending position of the object 
at a later time. These two positions are called keyframes. The software can 
then calculate the intermediate positions of the object between keyframes in a 
process called interpolation.

For example, you can use Bunkspeed DriveSuite to create a cube at the world 
origin. Next, right-click and select Add Keyframe to create the starting 
keyframe with the cube at the origin of the scene. Then use the Move 
Manipulator to move the cube elsewhere in the scene. Adjust the time in the 
Timeline to 2 seconds, and select Add Keyframe again from the right-click 
menu. If the timeline is set to 30 fps, then the application interpolates 
intermediate positions of the cube over 60 frames in 2 seconds.

Using the Move, Rotate, and Scale Manipulators in the Toolbar, you can 
transform an entire model set, an individual model, an individual part, a 
camera and a light in much the same way. (Note: If you wish to rotate an 
object more than 180 degrees, use a Rotation Animation instead of a regular 
keyframe.)

In the case of cameras and lights, you can change additional properties from 
one keyframe to the next (e.g. depth of field, focal length, light color and 
intensity, etc). In the case of materials, you can change all material properties 
between keyframes, except for textures (which cannot be animated).
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KEYFRAME ANIMATION

In Bunkspeed DriveSuite, you can animate entire Model Sets, individual 
models, individual parts, materials, lights, and cameras. The process for 
animating these items is described in this chapter. 

The instructions in this chapter make extensive use of the Animation Controls 
and Timeline (shown below). For detailed descriptions of each control, see 
“Animation Timeline and Controls” on page 60.

Basic Animation Controls Advanced Animation Controls

Animation List Timeline

For instructions on animating, see the following sections:

• About Splitting Parts into Pieces

• Assign Parts to Groups

• Move Pivot Points

• Animate the Selection

About Splitting Parts into Pieces
It is possible to animate the pieces of parts separately from each other by 
splitting a part into pieces first. For instructions. see “Splitting Models and 
Parts” on page 78.
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Assign Parts to Groups
This section describes how to group parts, so you can animate the group 
together. Parts do not have to be near each other to be grouped.

1. Begin by selecting the individual parts to group. To select multiple items 
one at a time, Ctrl-Click each item. Alternately, you can drag a selection 
box over the target items.

2. Right-click in the Tree of the Model Tab, and select Make Group.

Move Pivot Points
Every model, part, or similar item has a pivot point around which it moves. 
Sometimes you need to move default pivot points so selections will animate 
the way you wish:

1. Set the Object Manipulation Tool to Pivot mode.

2. Select the target part, group, or other target item in the scene. A 
Transform Manipulator appears at the pivot point of your selection. (Note: 
The default pivot point may not be in the location as the selected item.)

3. Using the Transform Manipulator to move and rotate the selected pivot 
point to the desired location, relative to the item it’s associated with. It’s 
the relative location that’s important with pivot points, not the absolute 
location of the pivot point.

Animate the Selection
You can animation the selected item (i.e. entire models, individual parts, 
groups of models and/or parts, materials, lights, and cameras) as follows:

1. Select the target item with the Selection Tool.

2. Right-click the selection and choose Add Keyframe from the context 
sensitive menu. (For rotation animations, select Add Rotation Animation 
instead.) A new animation appears in the Animation List, with the state of 
the selected item recorded in the first keyframe.

3. In the Timeline, set the maximum potential end time by dragging the red 
flag (end time) to the desired end time.

4. In the Timeline, drag the yellow flag (current time) to the desired time of 
the next keyframe.

5. Transform the selection as desired for the next keyframe.

6. Add the next keyframe either by clicking the Key icon in the Animation 
List, or by right-clicking and selecting Add Keyframe from the context 
sensitive menu.

7. Repeat steps 4 - 6 to add additional keyframes to the selected animation.

8. Use the Basic Animation Controls to evaluate and play the animation.
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ANIMATION RIBBON

The Bunkspeed Ribbon is an interactive animation tool for visualizing and 
editing keyframes, velocity, tension and motion ease. In this case, you will use 
the Ribbon to edit an existing animation:

1. In the 3D View of the open scene, the Bunkspeed Ribbon displays the 
3D path of animated items (unless you toggle off the visibility of the 
Ribbon), using the current interpolation. Within the Ribbon, keyframes 
appear as boxes. You can select these boxes and edit them directly using 
the Object Manipulator Tool. Moving a box moves that section of the 
Ribbon, which in turn customizes the 3D path of the animated item.

2. Play the animation using the Basic Animation Controls.

3. With a keyframe selected and the animation playing, experiment with 
adjusting the Transition, Curve Tension and Motion Ease in the Keyframe 
Properties palette. 

For example, change the Motion Ease and notice that setting 
“In” to maximum (+) causes the camera to slow while 
approaching the selected keyframe. The color shifts on the 
Bunkspeed Ribbon indicate velocity: green indicates 
acceleration and red indicates deceleration.
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Chapter 8: Saving and Outputting

SAVING IMAGES

In Bunkspeed DriveSuite, whenever you use File > Save Project to save a 
file, Bunkspeed  DriveSuite saves the open project in the Projects Library, in 
its native BIF format. The BIF format packages all assets associated with the 
project into a single file.

When you select File > Save Project As, Bunkspeed  DriveSuite gives you 
the choice of saving the BIF file to a different folder.

Bunkspeed  DriveSuite can open BIF files created in earlier versions of 
DriveSuite. However, once you save the project in Bunkspeed  DriveSuite, 
you cannot open it again in earlier versions.

OUTPUTTING IMAGES

Bunkspeed  DriveSuite can output images of your projects in the following 
ways by selecting the icons under the Render button in the Toolbar. From left 
to right, these icons do the following:

• Snapshot (High Speed) quickly captures what you see on your screen 
with a lot more user control than an ordinary screen shot.

• Render (High Quality) invokes raytracing at the quality and other custom 
settings that you specify. Several rendering modes are available.

• Animation renders a movie of the animations you have set up in the 
open scene.

• Turntable renders a series of frames showing your object(s) spinning on 
turntables.

• Sun Study renders a series of frames at different times of day.
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Snapshot (High Speed)
Taking a Snapshot of an open Bunkspeed  DriveSuite project uses the current 
camera to capture what you see in the 3D Viewport. Here’s how:

Configure Snapshots
You must do the following things before you take Snapshots:

1. Press CTRL-K to display the Options dialog. In the 3D Viewport Tab of 
that dialog, set the Maximum Resolution to the desired size (in pixels) of 
Snapshots.

Take a Shot

2. Click the Render Button located in the right corner of the Toolbar. In the 
Render Options dialog that then appears, choose the Snapshot tab.

3. In the Snapshot tab of the Render Options dialog:
– Image Format: Select the desired output format from the following 

options:
» JPEG
» Bitmap (bmp)
» TIF
» PNG
» Photoshop (psd)

– Save Camera File: If enabled, then  DriveSuite will save the camera 
you used to take the snapshot along with the snapshot itself. The 
camera file will be saved in the Cameras Library, and the snapshot 
will be saved in the Images Library.

4. Click Take Snapshot to finish, or Save and Close to save the current 
position and composition for later reference.
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Render (High Quality)
Bunkspeed  DriveSuite can generate high quality renderings that are 
incredibly realistic, but it can take some time depending on your hardware, the 
complexity of your Bunkspeed  DriveSuite project, and resolution of renders.

Here’s how you make a high quality rendering of the scene that’s open in 
Bunkspeed DriveSuite:

1. Click the Render Button located in the right corner of the Toolbar (or 
select Tools > Render from the Main Menu).

2. In the Render Options dialog that appears, choose Render from the tabs.

3. In the Render Options (described below), select your Render Options.

4. LEFT-CLICK Start Render to start the rendering process. The HUD will 
show the progress. When completed,  DriveSuite will save the rendering 
in the Bunkspeed Content \ Images Library by default.

RENDER OPTIONS
All or some of the following Render Options are available, depending on the 
Output Mode and other choices you make in the Render Options dialog:

Output File

• Filename: Give the file to be output a filename.

• Output Folder: The folder where the render will be saved.

• Image Format: Select the format of the output file from the list. (Note: 
The HDR format preserves 32-bit per channel RGB data, but the other 
formats do not.)

• Output Mode: Select from the following output modes:
– Render: Renders a single image using the current camera.
– All Cameras: Renders a single image using each and every camera 

in the open scene – producing the same number of renderings as you 
have cameras in the scene.

– All Configs: Renders all configurations in the project.
– Panoramic: Takes an image cube. (An image cube is 6 images taken 

from the same location, pointing at 90-degree angles from each 
other). Then it stitches those 6 shots together to form a 360-degree 
panorama around the camera. Then it outputs an HTML file, storing 
content images in a subfolder, so you can view the panorama in any 
browser. You can even pivot and zoom (but not pan) that camera the 
browser. This is very convenient for interior spaces, and can be used 
with Preview and Accurate renders.

– VR: Takes lots of stills from dozens of camera locations, in multiple 
orbits, to support the ability to move around the output model in any 
browser. Parameters:
» Orbits: Number of camera height levels.
» Images per Orbit: Renders from each camera orbit.
» Start Angle: Lowest angle of orbit
» End Angle: Highest angle of orbit
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• Render Output Passes renders a single standard image if you select 
“None”. Any other selection here also generates specialized output passes 
that you can use in post-processing software (such as Photoshop) to 
enhance the normal output pass. The drop-down options allow you to 
select which output passes you would like from the following options:
– Beauty: The regular raytraced image.
– Gloss: 50% rough chrome for isolating reflections.
– Specular: 100% chrome for isolating highlights.
– Black Specular: Same as Specular, but shows the reflections over a 

glossy black paint to collect the correct fresnel.
– Roughness: Renders each part based on its material roughness. 

This is an advanced version of the Gloss pass which retains per 
material roughness.

– Incandescent: Lights the scene using lights that have been placed in 
the scene, if any, but not the HDRI environment. If no lights have 
been manually placed in the scene, this output pass will be black.

– Ambient Occlusion: The same as Global Illumination, except for 
collecting the shadow information from an evenly lit white 
environment. With Ambient Occlusion, shadows are not colored, nor 
are they directional. 

– Ground Shadows: Only ground shadows.
– Global Illumination: Paints the objects in the scene flat white, and 

captures internal shadowing (i.e. the object shadowing itself).
– Object: The Object pass is a black and white mask to delineate 

between the 3D model in the scene vs the background.
– Depth: A depth pass renders the Z-depth of the camera in terms of 

greyscale value. A depth output can be used during post-processing 
to apply depth of field, fog, etc.

– Clown: Paints each part a separate flat color.

• Include Alpha: If enabled, the output file includes an alpha channel.

Resolution

• Resolution: The number of pixels (width by height) in the output file.

• Print Resolution: The pixels per inch in the output file.

• Print Size: The printed size of the output file, given its Resolution and 
Print Resolution.

• Print Units: Selects between inches and centimeters for Print Size.

Render Settings

• Render Selection: Lets you select between Preview and Accurate 
rendering engines:
– Preview: A realtime approximation of raytraced lighting.
– Accurate: Top quality rendering using new iRay and Stellar 

technology. Takes longer of course.

• Render Mode: Gives you the following options for high quality rendering:
– Time Limit: Stops the rendering after reaching the time limit you 

enter here, regardless of the final quality. After the render starts, you 
can optionally stop it early.
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– Quality: Stops the rendering after reaching the number of rendering 
passes you enter here, regardless of time.

• Advanced Caustics (Accurate render mode only): When enabled, the 
render supports physics-based spectrums through prisms, better vehicle 
interiors, and better simulation of light entering into an interior scene. It’s 
computational requirements are expensive.

Miscellaneous

• Send to Queue: When enabled, the current rendering will be added to a 
queue, so you can do it later. The default Queue Machine of “Local” 
renders the scene with your local PC. If you have PowerBoost installed 
and licensed, select “PowerBoost” as your Queue Machine to render the 
scene using powerful remote servers.

• Render in Background: When enabled, DriveSuite renders “in the 
background,” so  DriveSuite uses less memory -- allowing you to 
continue working. When disabled, you can choose between the following 
options for Render Selection:
– Raster: Uses hardware rendering to produce quick results at 

unlimited resolution.
– Raytrace: Uses iRay or Stellar raytracing to produce photo-real 

results.

• Boost Rendering: Enable to leverage other PCs on the same network to 
assist with rendering. Disable to use only your PC for rendering.

• Show Viewport: If enabled,  DriveSuite updates the real-time view in the 
3D Viewport to show the rendering as it happens.

• Render Using: Select CPU to use your CPU exclusively (good for users 
with a basic graphics card); select GPU to use your graphics card 
exclusively (good for users with a powerful graphics card); select Hybrid 
to use both your CPU and GPU.
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Animation
The rendering of animations is controlled with the following options:

• Animation Options

• Render Options

ANIMATION OPTIONS
The following options control the animation sequences:

Output File

• Filename: Give the file to be output a filename.

• Image Format: Select the format of the output images.

• Render Output Passes renders specialized output passes that you can 
use in post-processing software (such as Photoshop) to enhance the 
normal output pass. The drop-down options allow you to select which 
output passes you would like. For details, see the extended explanation of 
“Render Output Passes” in “Render (High Quality)” on page 103.

• Movie Format: Sets the format of the output movie.

• Include Alpha: If enabled, the output file includes an alpha channel.

Animation

• Create Movie: If enabled, DriveSuite encodes the animation data into a 
movie format using the parameters below:

• Start Frame: Sets the first frame to render in the animation sequence.

• End Frame: Sets the last frame to render in the animation sequence.

• Start Time: Sets the time the animation begins, relative to the zero 
keyframe.

• End Time: Sets the time the animation ends, relative to the zero 
keyframe.

• Frames Per Second: (read-only) The frame rate of playback.

RENDER OPTIONS
The rendering options for animations are almost identical to the standard 
Render (High Quality) options.
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Turntable
Here’s how you make a series of high quality renderings that show your 
models rotating 360 degrees around their own centers, or together around the 
world origin:

1. Click the Render Button located in the right corner of the Toolbar.

2. In the Render Options dialog, choose the Turntable type.

3. In the Render Options page, select the basic rendering options.

4. In the Turntable Options page, select the options controlling the turntable.

5. LEFT-CLICK Start Turntable Render to start the rendering process. The 
HUD will show the progress. When completed, DriveSuite will save the 
rendered images in the Images Library by default.

TURNTABLE OPTIONS

Output File

• Filename: Give the file to be output a filename.

• Image Format: Select the format of the output images.

• Render Output Passes renders specialized output passes that you can 
use in post-processing software (such as Photoshop) to enhance the 
normal output pass. The drop-down options allow you to select which 
output passes you would like. For details, see the extended explanation of 
“Render Output Passes” in “Render (High Quality)” on page 103.

• Movie Format: Select the format of the output movie.

• Include Alpha: If enabled, the output file includes an alpha channel.

Animation

• Create Movie: If enabled, DriveSuite encodes the animation data into a 
movie format using the parameters below:

• Start Angle: Sets the initial angle of the turntable(s) on the first frame of 
the animation.

• End Angle: Sets the final angle of the turntable(s) on the last frame.

• Direction: Lets you spin the turntable either clockwise or 
counterclockwise.

• Number of Frames: Sets the total number of frames to render in the 
entire sequence.

• Start Frame: Sets the first frame to render in the animation sequence.

• End Frame: Sets the last frame to render in the animation sequence.
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• Frames Per Second: Sets the frame rate of intended playback.

Sun Study
Here’s how you quickly and easily animate the rise and fall of sunlight over a 
specific time frame: 

1. Click the virtual Render Button located in the right corner of the Toolbar.

2. In the Render Options dialog that appears, choose the Sun Study type of 
rendering.

3. In the Render Options page, select the basic rendering options you 
prefer.

4. In the Sun Study Options page, select the options controlling the sun 
study.

5. LEFT-CLICK OK to start the rendering process. The HUD will show the 
progress. When completed, DriveSuite will save the rendered images in 
the Images Library by default.

SUN STUDY OPTIONS
You control the turntable via the following parameters:

Output File

• Filename: Give the file to be output a filename.

• Image Format: Select the format of the output file from the list.

• Render Output Passes renders specialized output passes that you can 
use in post-processing software (such as Photoshop) to enhance the 
normal output pass. The drop-down options allow you to select which 
output passes you would like. For details, see the extended explanation of 
“Render Output Passes” in “Render (High Quality)” on page 103.

• Movie Format: Select the format of the output movie.

• Include Alpha: If enabled, the output file includes an alpha channel.

Animation

• Create Movie: If enabled, DriveSuite encodes the sun study as a movie.

• Start Hour: For scenes using a Sky Study Environment, Start Hour sets 
the time of day the turntable animation begins.

• End Hour: For scenes using a Sky Study Environment, Start Hour sets 
the time of day the turntable animation begins.

• Number of Frames: Sets the total number of frames to render in the 
entire sequence.

• Start Frame: Sets the first frame to render in the animation sequence.
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• End Frame: Sets the last frame to render in the animation sequence.

• Frames Per Second: Sets the frame rate of intended playback..
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HOT-KEYS

Using hot-key shortcuts (i.e. keyboard and mouse combinations), you can 
quickly access many of the functions in Bunkspeed DriveSuite:

• To display current hot-key shortcuts, press F12. 

• For most hot-keys, hold the Ctrl-Key to make any adjustment in finer 
steps (i.e. typically 1/10 the step size of the default).

Table of Hot-Keys

General

Ctrl+N New Project

Ctrl+S Save Project

Shift+Ctrl+S  Save As (.bif)

Ctrl+O Open Project

Ctrl+W Close Project

Ctrl+F4 Close Project

Ctrl+K Open Options

Alt+F4 Close Application

Ctrl+Q Close Application

Edit

Ctrl+Z Undo

Ctrl+Y Redo

Shift+Ctrl+Z Redo

Ctrl+C Copy

Ctrl+V Paste

Backspace Delete

Delete Delete
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Mode

F1 Help

Spacebar Toggle Easy Mode

Ctrl+1 Model Mode

Ctrl+2  Material Mode

Ctrl+3  Scene Mode

Ctrl+5  Camera Mode

Ctrl+0  Library Mode

Ctrl+P Snapshot Using Current Settings

~ Cycle through render modes

Ctrl+L Toggle Timeline

Ctrl+Home Previous Selection Mode

Ctrl+End Next Selection Mode

Ctrl + Page Up Previous Manipulation Modee

Ctrl + Page Down Next Manipulation Mode

Display

F12 Toggle Hot Keys pop-up window

F11 Toggle Full Screen

Tab Cycle Through Editable Interface Items

Ctrl+U Toggle Heads-Up Display (HUD)

Shift+Ctrl+P Pause/Resume Raytracing

Presentation

Alt+1 Next Model Set

Shift+Alt+1 Previous Model Set

Alt+= Next Configuration

Shift+Alt+= Previous Configuration

Alt+3 Next Environment

Shift+Alt+3 Previous Environment

Alt+4 Next Plate

Shift+Alt+4 Previous Plate
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Alt+5 Next Camera

Shift+Alt+5 Previous Camera

Manipulation

RMB in Center of Transform Manipulator Snap Selected Object to Surface

Shift+Ctrl+LMB Center Selection

Shift+Ctrl+RMB Focus on Selection

Shift+Alt+RMB Look at (without moving camera)

Selection

Ctrl+A Select All

Shift+Ctrl+A Switch selection modes

Ctrl+H Hide Selection

Shift+Ctrl+U Show All

Shift+Ctrl+H Show Only

Scene

Shift+Ctrl+F Toggle Ground Reflections

Shift+Ctrl+G Flatten Ground

Shift+Ctrl+E Toggle Environment Visibility

Shift+Ctrl+B Toggle Backplate Visibility

Ctrl+Alt+LMB Rotate Environment

Ctrl+E Load Environment Image

Ctrl+B Load Backplate Image

Ctrl+G Toggle Grid (Visible when Raytrace is turned off)

Shift+Ctrl+[ Decrease Environment Brightness by .05

Shift+Ctrl+] Increase Environment Brightness by .05

Shift+Ctrl+; Decrease Environment Gamma by .05

Shift+Ctrl+' Increase Environment Gamma by .05

Ctrl+[ Increase Environment Brightness by .25

Ctrl+]   Increase Environment Brightness by .25

Ctrl+;   Decrease Environment Gamma by .25

Presentation
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Ctrl+' Increase Environment Gamma by .25

F10 Accumulate

Material Controls

Double Click LMB Select Material and its Properties

Shift+LMB Copy Material (When in Material Mode)

Shift+RMB Paste Material (When in Material Mode)

Camera Controls

Alt+LMB Tumble Camera

Alt+MMB Pan Camera

Alt+RMB Zoom Camera

Alt+Scroll Wheel Increase/Decrease Perspective

Alt+Shift+C Reset Camera

Ctrl+Shift+L Lock Camera

Alt+Ctrl+RMB Pick Camera Look-At Point

Alt+Shift+RMB Pick Camera Focus Point

Animation

Shift+Ctrl+K Create Keyframe

Scene
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SUPPORTED IMPORT FORMATS

In addition to its native file format (BIF), the application can import a variety of 
common formats for 3D models, HDR environment images, and standard 2D 
images. See the following sections for details:

– Import formats for 3D Models
– Import Formats for HDR Environments
– Import Formats for Backplates and Textures

Import Formats for 3D Models
The following file formats are supported, natively or through plugins that you 
can download rom the Bunkspeed Community.

– SolidWorks 2013 and earlier (SLDASM, SLDPRT) or plugin
– Maya 2014 and earlier
– Alias 2014 and earlier
– Drive Pro/ENGINEER Wildfire 2, 3, 4 (ASM, PRT) via plugin (Drive 

Pro/ENGINEER must be installed and licensed)
– Pro/E and CREO plugin.
– Rhino 5.0 and prior (.3DM) direct or via plugin
– SketchUp 8 or prior (.SKP) direct or via plugin
– ALIAS Studio (.WIRE) via plugin. Alias must be installed and 

licensed.
– Alibre (via IGES or STEP)
– 3D Studio Max (.3DS)
– IGES (IGS)
– STEP (STP)
– OBJ
– Filmbox (FBX) stills only (not animations) 
– Collada (DAE)
– 3DXML
– DWG
– DXF
– Inventor

Import Formats for HDR Environments
The text below is adapted from Wikipedia:
http://en.wikipedia.org/wiki/High_dynamic_range_imaging

HDR stands for High Dynamic Range Imaging, which is a set 
of techniques that allow a much greater range between light 
and dark areas of an image than normal imaging techniques. 
HDR is designed to accurately reproduce the wide range of 
lighting levels found in real scenes from direct sunlight to 
deep shadows.

Information stored in high dynamic range images usually 
corresponds to the physical values of luminance or radiance 
that can be observed in the real world. This is different from 
traditional digital images, which represent colors that should 
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appear on a monitor or a paper print. Therefore, HDR image 
formats are often called "scene-referred", in contrast to 
traditional digital images, which are "device-referred" or 
"output-referred".

Furthermore, traditional images are usually encoded for the 
human visual system (maximizing the visual information 
stored in the fixed number of bits), which is usually called 
"gamma encoding" or "gamma correction". The values stored 
for HDR images are often linear, which means that they 
represent relative or absolute values of radiance or 
luminance (gamma 1.0). 

Bunkspeed  DriveSuite uses HDR images for environments that radiate the 
light in your scenes.  DriveSuite supports two formats for HDR images: EXR 
and HDR. Both are described below.

OPENEXR (EXR)
OpenEXR (.EXR extension) is a high dynamic range imaging image file 
format that stores a vast exposure range and color depth by providing 32-bits-
per-channel of RGB information.

HIGH DYNAMIC RANGE IMAGE (HDR)
High Dynamic Range Images (.HDR extension) is a high dynamic range 
imaging image file format that stores a vast exposure range and color depth 
by providing 32-bits-per-channel of RGB information.

Import Formats for Backplates and Textures
Bunkspeed  DriveSuite can import the following 2D file types for use as 
backplates or textures for use in materials. These formats cannot be used as 
environmental images, and cannot emit light into your project.

– Bitmaps (BMP)
– Targa (TGA)
– GIF
– JPEG (JPG)
– PNG
– TIFF (TIF)
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TYPES OF MATERIALS IN BUNKSPEED  
DRIVESUITE

Bunkspeed  DriveSuite includes a material library that contains many pre-
configured materials. All Bunkspeed  DriveSuite materials are based on 
scientifically accurate materials. 

Each type of Bunkspeed  DriveSuite material is defined by a unique set of 
Material Parameters and Texture Properties that simulate a real material, 
such as glass or leather. When you select a material in the Material Library, or 
on an object, you can view and edit its Material parameters and Texture 
properties in the Material Tab of the Palette.

For details on the properties of Color, Specular, Alpha, and Bump textures 
that you can optionally assign to materials, see Texture Parameters. and 
“Texture Mapping” on page 29. For details on the Material Parameters that 
are unique to each type of pre-defined Bunkspeed  DriveSuite material, see 
the sections below:

• Anisotropic

• Backscattering

• Emissive

• Flat

• Generic

• Glass

• Gem

• Matte

• Metal

• Metallic Paint

• Multi-Layer

• Paint

• Plastic

• Subsurface Scattering

• Thin Film
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Anisotropic
The Anisotropic material simulates a surface with an asymmetrical specular 
highlight that changes when the surface rotates, relative to the light sources. 
Put another way, an anisotropic material has a "grain" or directionality. This 
material is most commonly used to simulate brushed finishes on metallic 
surfaces. The material’s parameters are:

• Base Color: sets the color of the material in diffuse white light

• Highlight Color: sets the color of the material’s specular highlights

• Roughness: controls the size of the highlight. The rougher the material, 
the more it diffuses the highlight (i.e. the larger and less focused the 
highlight becomes).

• Distortion: controls the amount of distortion by changing the ratio of 
roughness in one direction on the surface, verses the perpendicular 
direction. Zero causes no distortion, and 100 causes maximum distortion.

• Angle: sets the direction of the Distortion effect.

Backscattering
Backscattering is great for fabrics. It works well with Bump map textures. 
Parameters:

• Base Color: controls the darker color of the base material.

• Highlight Color: controls the color of specular highlights.

• Roughness: low values for things like satin; high value for leather, velvet, 
and so forth.

• Distortion: influences the anisotropic light to achieve an effect similar to 
changing the direction of the stitching in the fabric.

• Angle: controls the light direction of Distortion (above).

Emissive
The Emissive material emits light into the scene – provided that you assign a 
Color texture (the only type of texture supported by emissive materials) and 
enable the Blend Texture option in the Texture Parameters of Material Tab. 
If you don’t do this, then the Emissive material will reflect the light that’s 
shining on it, but will not radiate any additional light into the scene – even if 
you crank up the Intensity parameter very high.

• Color: in the absence of light, the material radiates the Emissive color. In 
typical scenes, the color the Generic material is the sum of Base Color 
plus Emissive Color (plus Highlight Color for highlights).
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• Intensity: multiplies the Color value, by adding luminance (i.e. causing 
more light to be emitted by the material). Due to clipping in monitors, 
adding intensity can make the Color appear washed out. To 
counterbalance this tendency, add saturation to the Color value after 
increasing Intensity.

Flat
The Flat material is not shaded, so it does not react to light or shadows. 
Hence, the Flat material has a constant color regardless of lighting and 
shadows. The Flat material is so obviously unrealistic, it is perfectly suited for 
masking and such.

• Color: sets a fixed color for the material. This color does not change 
regardless of the light falling on the material (i.e. this material is not 
shaded).

Generic
The Generic material can simulate a wide range of materials – making it 
possible to precisely control how light interacts with a material. This material’s 
parameters are as follows:

• Diffuse Color: sets the color of the material in diffuse white light

• Specular Color: sets the color of the material’s specular highlight

• Transparency Color: the tint acquired by light passing through partially 
transparent materials.

• Diffusion: how much light diffuses through partly transparent materials.

• Roughness: simulates surface roughness by controlling the size of the 
highlights in reflected light. The rougher the material, the more it diffuses 
highlights (i.e. the larger and less focused the highlight becomes).

• Emission: Causes this material to emit light into the scene.

• Internal Roughness: simulates internal roughness that affects light 
refracting through the material instead of reflected off its surface.

• IOR: directly controls how much materials with transparency bend light 
passing through them; indirectly affects reflectivity.

• Solid: toggles two-sided verses one-sided properties (e.g. IOR Out 
applies only to two-sided objects)

• Color Density: adds more of the Diffuse Color (i.e. from faint to intense) 
as the object gets thicker.
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Glass
The Glass material is optimized for windows. It can handle thin or thick glass. 
Typical applications include the windshield and head lamps of an automobile. 
This material’s parameters are as follows:

• Solid: toggles two-sided verses one-sided properties (e.g. IOR Out 
applies only to two-sided objects)

• Color: sets the color of the material in diffuse white light.

• IOR: sets the index of refraction (i.e. the amount of bending) of light 
passing into the glass. When using a surface without thickness, the IOR 
will affect the reflectivity of the surface, but the light passing through it will 
not refract. On a surface with thickness, this material will cause light to 
refract as it passes through the Solid object.

• IOR Out: sets the index of refraction (i.e. the amount of bending) of light 
passing out of the glass. (Note: Transparent objects with thickness, like 
most gems and glass, refract light when entering and leaving the object.)

• Thickness (mm): determines the intended thickness of the simulated 
surface, compared to comparable solid glass in reality.

• Roughness: controls the size of the highlight. The rougher the material, 
the more it diffuses the highlight (i.e. the larger and less focused the 
highlight becomes) – such as with frosted glass.

Gem
The Gem material is a version of the Glass material that’s been optimized for 
gem stones. This material’s parameters are the same as Glass – except for 
the addition of the Abbe Number parameter.

Matte
This simple material simulates matte surfaces, like flat paint with no specular 
highlights. This material’s parameters are as follows:

• Color: sets the color of the material in diffuse white light

Metal
The metal material is used to simulate metals such as aluminum, gold, and 
silver, with different finishes such as polished, powder coated, cast, etc. This 
materials parameters are:

• Color: sets the color of the metal in diffuse white light

• Roughness: determines how much the metal diffuses specular 
highlights. A value of zero would cause no diffusion at all, which would 
make the metal appear very smooth with sharp specular highlights.
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Metallic Paint
This material simulates metallic paints such as car paints, but can also be 
used to simulate multilayer plastic finishes. This materials parameters are:

• Face Color: sets the primary base color of the paint in diffuse white light.

• Flop Color: introduces a second color into this material. 

• Travel: balance between Face Color and Flop Color. More travel means 
more Face Color and less Flop Color.

• Flake Color: sets the color of the metallic flake in diffuse white light

• Flake Roughness: the roughness off the flakes themselves.

• Flake Coverage: the density of the metallic flakes. 

• Clearcoat: If enabled, the paint acquires a shiny wet look typical of a 
clearcoat on top the metallic paint itself.

• Clearcoat Tint: adds a transparent color on top of Face and Flop and 
Flake.

• Clearcoat Roughness: determines the degree the clearcoat diffuses 
specular highlights. A value of zero would cause no diffusion at all, which 
would make the clearcoat appear very smooth and shiny.

• Physical Flakes: If enabled metallic flakes in the paint have physical 
size.

• Flake Size: the actual size of the physical flakes.

• Flake Angle: the actual angle of the physical flakes.

Multi-Layer
The Multi-Layer type of material consists of up to four other materials stacked 
on top each other to create sophisticated material renditions with ease. For 
example, you could stack a Glass layer on top a Carbon Fiber layer, or a Dirt 
texture map on top a Car Paint layer. You choose the materials and stacking 
order.

Paint
This material simulates non-metallic paint. Parameters:

• Color: sets the color of the material in diffuse white light

• Clearcoat: the index of refraction (IOR) of the clear coat. It indirectly 
determines the surface reflection on the clear coat.

• Clearcoat Roughness: determines how much the clearcoat diffuses 
specular highlights. A value of zero would not diffuse reflections at all, 
causing specular highlights to be pinpoint sharp.
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Plastic
The Plastic material is optimized to simulate many plastic types. This 
material’s parameters are:

• Color: sets the color of the material in diffuse white light

• Highlight Color: sets the color of the material’s specular highlight

• Transparency Color: the tint acquired by light passing through partially 
transparent materials.

• Diffusion Color: scattering of light in translucent materials, such as clear 
plastic.

• IOR: directly controls how much the material bends light passing through 
it, and indirectly affects reflectivity.

• Roughness: controls the size of the highlight. The rougher the material, 
the more it diffuses the highlight (i.e. the larger and less focused the 
highlight becomes).

Subsurface Scattering
This material type works only in high quality Rendering Modes. This material 
is great for milk, teeth, some stones, honey, etc. Parameters:

• Absorption: the color that’s being absorbed as light is passing through 
the material.

• Scattering: the degree of bouncing light within the material. More 
scattering means more cloudy.

• Reflection: the color of light bouncing off the surface of the material.

• IOR: affects the reflectivity and diffraction of the surface.

• Thickness: how thick the applied object is in real life.

Thin Film
Thin film simulates soap bubbles, oil slicks, etc. with rainbow color distortion 
on the surface layer. Parameters:

• Color: the base color of the material. Supports transparency.

• IOR (index of refraction): the material’s reflectivity and distortion of light 
penetrating it.

• Film IOR: changes the IOR of the surface layer separately from the base. 
Strongly affects color on the surface layer.

• Film Thickness: The thickness of the overall material. Very thin films are 
mostly surface layer, which tends to have strong visual effects. Thicker 
films take on more of the base material’s properties, with less effect from 
the surface layer.
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• Film Thickness Randomness: affects randomness in the color patterns 
on the surface layer. Higher values produce wider color and pattern 
variations.

• Roughness: affects shininess mostly.

GLOSSARY

The following glossary covers key 3D terms that you should become familiar 
with before getting serious.

3D Three-dimensional. Descriptive of a region of space that has width, height and 
depth.

Algorithm A procedure or formula for solving a mathematical problem. Algorithms are 
commonly used for such tasks as generating textures, rendering images and 
controlling mathematically based behavior patterns.

Alpha Channel The top byte of a 32-bit pixel that is used for data other than color. The alpha 
channel commonly holds mask data, enabling an image to be separated from 
its background for use in compositing.

Ambient Light An artificial illumination level representing infinite diffuse reflections from all 
surfaces within a 3D scene, ensuring that even surfaces without direct 
illumination become visible to the user. 

Alpha Channel The top byte of a 32-bit pixel that is used for data other than color. The alpha 
channel commonly holds mask data, enabling an image to be separated from 
its background for use in compositing. 

Ambient Light An artificial illumination level representing infinite diffuse reflections from all 
surfaces within a 3D scene, ensuring that even surfaces without direct 
illumination become visible to the user.

Animation A medium that creates the illusion of movement through the projection of a 
series of still images or ‘frames’. The term is also used to refer to the 
techniques used in the production of an animated film - in 3D animation, 
primarily those controlling the motion of the objects and cameras within a 
scene. These include keyframe animation, in which the artist sets the 
positions of objects manually at certain key points in the action, and the 
computer calculates their intervening positions through a process of 
interpolation or ‘inbetweening’, and procedural animation, in which the motion 
is controlled automatically via a series of mathematical formulae.
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Anti-aliasing A method of reducing or preventing rendering artefacts by using color 
information to simulate a higher screen resolution. The term is often applied to 
the process of softening the unnaturally precise or stepped edges (sometimes 
known as ‘the jaggies’) created when a computer generated object is placed 
against a contrasting background by using pixels of intermediate shades as a 
buffer between the two.

Aperture In a real camera, the size of the opening that light passes through (usually 
given in terms of its f-stop) in order to reach the film. The larger the f-stop, the 
smaller the opening. 3D software packages sometimes mimic the effects of 
different aperture settings on a recorded image during the rendering process.

Aspect Ratio The ratio of the width of an image to its height. Common aspect ratios for 
broadcast images include 4:3 and 16:9 (widescreen).

Axis A hypothetical linear path around which an object can be rotated, or across 
which it can be mirrored. In the Cartesian co-ordinate system, the three world 
axes, X, Y and Z (width, height and depth) define directionality within the 3D 
universe. Hence, a co-ordinate of (0,0,0) defines the origin of the world.

Beauty Pass When rendering multiple passes of a scene, the beauty pass is the one that 
features the most significant information about the objects within it. This 
usually includes the main, full-color rendering of those objects, including 
diffuse illumination and color. A beauty pass will not include reflections, 
highlights, and shadows, which are usually separate passes.

Bit Depth The number of bits used to define the shade or color of each pixel in an 
image, a ‘bit’ being the smallest unit of memory or storage on a computer. 
(One ‘byte’ is eight ‘bits’.) A 1-bit image is black and white. An 8-bit image 
provides a 256-color palette. A 24-bit image provides 16.7 million possible 
colors: a palette sometimes known as ‘True color’. A 32-bit image provides 
the same palette, plus an 8-bit greyscale alpha channel.

Bitmap Strictly speaking, a bitmap is a 1-bit black-and-white image. However, the 
term is often loosely applied to any two-dimensional image, regardless of bit 
depth. Still image manipulation packages such as Photoshop and Paint Shop 
Drive are sometimes referred to as ‘bitmap editors’.

Bluescreen Footage Live footage shot against a backdrop of a single uniform color (usually blue or 
green) with a view to compositing it into a computer generated background. 
Every pixel with the same color value as the backdrop is replaced by the CG 
image.

Bounding Box The smallest regular-shaped box that encloses a 3D object, usually 
rectangular in shape.
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Bump Map A black-and-white image used by a 3D software package to simulate the 
three-dimensional detail on the surface of an object. When projected over the 
surface of the object, parts of the surface beneath white areas of the image 
are raised; those beneath black areas are depressed. Bump mapping is 
purely a rendering effect, however, and does not affect the underlying 
geometry of the model.

CAD Computer Aided Design. The use of computer-based models of objects for 
visualization or testing as an aid in the design process. CAD software 
packages usually contain more precise real-world measuring tools than 
ordinary 3D packages, but fewer surfacing and animation features.

Camera A virtual viewpoint in 3D space that possesses both position and direction. In 
a 3D scene, the camera represents the viewer’s eye. When the scene is 
rendered at final quality, it is the camera view that is used, rather than the one 
seen in the software’s workspace. This enables the artist to move around the 
workspace without disturbing the camera view.

Camera Mapping A technique by which geometry matching the size and perspective of objects 
shown within a still image is constructed, and the original image mapped back 
onto those objects. This permits limited camera movement around the picture, 
giving the illusion of a 3D environment from a 2D image.

Camera Move A movement of the virtual camera within a 3D software package analogous to 
one in real-world cinematography. Common camera moves include dollying, 
in which the camera angle remains fixed, but the camera moves towards or 
away from the subject; panning, in which the camera position remains fixed, 
but the camera tilts or swivels in any direction to follow the action; and 
tracking, in which the camera moves in a single plane at right angles to the 
area of interest.

Camera Path The path in virtual space along which the camera moves during the course of 
an animation.

Caustics Patches of intense illumination caused by the refraction of light through a 
transparent object or the reflection of light from a reflective surface. One 
common example would be the shifting patterns of light and shade cast on the 
floor of a swimming pool on a sunny day. Rendering software has only 
recently become sophisticated enough to mimic such complex real-world 
lighting effects as caustics.

CGI Computer Generated Imagery. An image or images created or manipulated 
with the aid of a computer. The term is often used to refer specifically to 3D 
computer animation, although it is really more widely applicable.
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Channel For a two-dimensional image, a channel is a sub-image composed only of the 
values for a single component of a given pixel. A greyscale image has one 
color channel, an RGB image has three, and a CMYK image has four. When 
applied to materials, the term refers to one particular subset of the properties 
which determine the way in which a surface reacts to light, including color, 
reflectivity, transparency, diffusion, specularity and bump.

color Bleeding A physical phenomenon by which the color of one object is seemingly 
transferred to a neighboring object by light bouncing from one surface to the 
other. Like caustics, color bleeding is a complex real-world lighting effect, and 
one that rendering software has only recently become able to simulate 
accurately.

color Space A mathematical method for defining the way in which color is represented 
within an image. Common color spaces include RGB (Red, Green, Blue), 
which has a bit depth of 24, and is commonly used in broadcast applications, 
and CMYK (Cyan, Magenta, Yellow, Black), which has a bit depth of 32, and is 
used for print illustration work.

Compositing The process of combining multiple images into a single image. This is often 
performed in films to make a live actor appear on a computer generated 
background, or vice versa. It can also be used following multi-pass rendering 
to combine the various render passes in different ways to control the look of a 
scene.

Compression A technique for reducing the quantity of data required to make up a digital 
image. Compression techniques can be non-destructive (‘lossless’) or 
destructive (‘lossy’), in which part of the data set is discarded permanently. 
Converting still images into JPEG format is one example of lossy 
compression.

Constrain To restrict the motion of an object to one or two planes, or to a certain range of 
values within a plane, in order to simplify the process of animation. 
Constraints are commonly imposed on joints within a skeleton during the 
process of rigging a character for animation, in order to prevent that character 
from performing actions that would be physically impossible.

Co-ordinate System A set of numerical values used to denote a location in 3D space. In the 
Cartesian co-ordinate system, three orthogonal ‘world axes’ (the X, Y and Z 
axes) are used to define the position of a point relative to the intersection of 
these axes, or origin. Other co-ordinate systems can be used for modelling 
and texture projection. 
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DoF Depth of Field. The depth of field of a specific lens is the range of acceptable 
focus in front of and behind the primary focus setting. It is a function not only 
of the specific lens used but also of the distance from the lens to the primary 
focal plane, and of the chosen aperture. Larger apertures will narrow the 
depth of field; smaller apertures will increase it.

Environment Map An image intended to entirely enclose a scene, either to provide a convincing 
background, or to project real-world lighting or reflection data onto the surface 
of an object.

Extrusion A modelling technique in which a two-dimensional outline or profile is 
duplicated outwards along a linear path, and the set of duplicated profiles 
joined to create a continuous three-dimensional surface.

Face The front or back of an extruded object. The shape from which a 3D object 
has been extruded.

Fall-off The way in which the intensity of a light diminishes with the distance from its 
source. In the real world, the fall-off of light is governed by the inverse square 
law, which states that the intensity is inversely proportional to the square of 
the distance. However, in 3D software packages, it is possible to use a variety 
of different mathematical formulae to describe the relationship. 

File Format The format in which the data making up a particular 3D object or scene is 
stored. File formats come in two types: object formats, such as the LWO 
format in LightWave or 3DS format in 3ds max, which contain only details of 
the geometry and surface properties of an object; and scene formats, such as 
their LWS and MAX equivalents, which contain such global information as 
lighting, animation or camera data. Other file formats supported by most 
major 3D software packages include the DXF and IGES formats for CAD and 
NURBS models, the OBJ object format, and the cross-platform FBX format 
developed by Kaydara for the interchange of motion data between 3D 
applications. 

Flythrough A type of animation in which the camera moves around a scene, rather than 
objects moving in front of a stationary camera. 

Frame A still two-dimensional image. In computer animation, the term ‘frames per 
second’ (fps) is a measurement of the number of still frames displayed in one 
second to give the impression of a moving image. For film work, this value is 
usually 24; for the European PAL broadcast format, 25; and for the US NTSC 
broadcast format, 30 fps. 

F-Stop See: Aperture
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Global Illumination A superset of the radiosity and raytracing rendering techniques. The goal of 
Global Illumination rendering is to compute all of the possible light interactions 
between surfaces in a given scene, and thus obtain a truly photorealistic 
image. All combinations of diffuse and specular reflections and transmissions 
must be accounted for. Effects such as color bleeding and caustics must also 
be included in a global illumination simulation. 

Group A set of sub-objects within a model or scene that move and behave as a 
single entity, yet can still be split apart (ungrouped), if necessary. Most 
complicated models are constructed from several less complex parts that 
need to maintain the same spacing and orientation; grouping provides a way 
of locking the relative positions of the objects without joining them 
permanently. 

GUI Graphical User Interface. An icon-based interface that controls a 3D software 
package. Although the GUI varies from program to program, there are certain 
basic conventions governing the layout of the main professional 3D 
applications. 

Hard-Body Dynamics Also known as rigid-body dynamics, hard-body dynamics simulate the 
physical behavior of rigid objects that do not deform upon collision. 

Hardware Rendering Also known as display rendering, hardware rendering previews a 3D scene 
within the viewports on a 3D software package, providing real-time on-screen 
feedback about the effects of changes made to that scene, but omitting 
certain processor-intensive effects such as volumetrics, shadowing and 
realistic refraction. 

HDRI High Dynamic Range Image. A 2D image stored in a file format with a greater 
range of luminance values than a standard bitmap image. HDR images are 
often used as environment maps in image-based lighting techniques to create 
subtle, real-world lighting effects. 

Hierarchy The relationship of the sub-objects within a model or a scene to one another. 
Sub-objects may exist as parents, children or independents. A parent object 
controls the motion of all child objects linked to it, although the motion of a 
child object does not affect that of the parent. 

History A record of the previous values of the attributes of a 3D scene, enabling an 
artist to revert immediately to a particular earlier state. The history is 
especially valuable during the modelling process. 

Image-Based Lighting A technique in which a photographic reference image is used as an 
environment map to control the surface illumination of a 3D object, in order to 
create subtle real-world lighting effects. 
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In-betweening The generation of intermediate transition positions between two keyframes. 
The term is drawn from traditional cel animation, where a lead artist generates 
the beginning and end keyframes of a sequence (typically one second apart), 
a breakdown artist does the breakdowns (typically four frames apart), and an 
‘in-betweener’ completes the rest. 

Interpolation The mathematical procedure by which a 3D software package calculates the 
in-between positions between two keyframes. 

Invisible A point within a 3D scene that does not render out, but which is used as a 
reference for other objects. 

Joints Points of articulation between the bones in a character rig. Put another way, a 
joint is a group of parts that can be moved separately from the rest of a model 
– with the movement taking place relative to a pivot point.

Keyframe An image, or set of attributes for a 3D scene, used as a reference point in 
animation. The artist usually sets up keyframes manually at significant points 
in the action, and the computer calculates the inbetween values automatically. 

Layer A level of an image that can be edited independently of the rest of the image. 

Lens In a real camera, a lens is a curved piece of glass or other transparent 
material that focuses light onto the film. Modern 3D software is capable of 
simulating a variety of optical distortions created by imperfections in real-
world lenses, adding realism to the rendered output. 

Lens Flare A bright pattern on an image caused by the reflection and refraction of light 
within a camera. Although lens flares are actually artefacts of the 
photographic process, many 3D software packages offer artists the 
opportunity to add them deliberately in order to increase the realism of 
rendered output. 

Light A point or volume that emits light onto a 3D object. Types of light supported 
within 3D packages include Point lights, which emit light in all directions from 
a single point; Spot lights, which emit light in a cone; Distant or Directional 
lights, which emit light rays in parallel, illuminating all surfaces within a scene; 
and Area lights, which emit light from two-dimensional surfaces. 

Look Development The process of developing the look of a 3D scene by compositing separate 
render passes together in different permutations.
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Material A set of mathematical attributes that determine the ways in which the surface 
of a model to which they are applied reacts to light. These attributes are sub-
divided into individual channels. 

Mask An area that can be protected and isolated from changes applied to the rest of 
the image. 

Mesh The surface geometry of a 3D model, made up of a series of linked geometry 
elements such as polygons, patches or NURBS surfaces. 

Model Used as a verb, to model means to build a 3D object. Used as a noun, it 
means the 3D object created as the end product of the modelling process. A 
variety of different methods are used in 3D modelling, including polygonal, 
NURBS, Sub-D and metaball techniques. 

Motion Blur An artefact of real-world cinematography in which the camera’s target object 
is moving too quickly for the camera to record accurately, and therefore 
appears blurred. Many 3D software packages simulate motion blur as a 
rendering effect, in order to increase the realism of 3D images or animation. 

Multi-pass rendering To render out the lighting or surface attributes of a scene as separate images, 
with a view to compositing them together later. Multi-pass rendering can be 
used simply to speed up the rendering process, or in order to develop the look 
of a scene by compositing the different passes together in various 
permutations. 

Negative Light A light within a 3D scene that decreases the illumination on a surface instead 
of adding to it. Negative lights can be used to remove ‘overspill’ in brightly lit 
scenes. 

Normal An imaginary line drawn from the centre of a polygon (or other geometry 
object) at right angles to the surface. 

NURBS Non-Uniform Rational B-Splines. NURBS curves are two-dimensional curves 
whose shape is determined by a series of control points or CVs between 
which they pass. When a series of such curves are joined together, they form 
a three-dimensional NURBS surface. Such surfaces have a separate co-
ordinate space (known as UV co-ordinate space) to that of the 3D scene in 
which they are situated. NURBS are commonly used to model organic 
curved-surface objects. 

Object A generic term describing any item that can be inserted into and Models, 
lights, particle emitters and cameras are all objects. 
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Object file See: File format.

Particle System An animation system consisting of a large number of very small points whose 
behavior is determined mathematically. A particle system typically consists of 
an emitter (which may be a point, surface or volume, and may emit particles 
directionally or in all directions) and a series of fields that determine the 
motion of those particles. Individual particles have a finite lifespan, and may 
possess attributes (such as color, radius, and opacity) that vary over the 
course of that lifespan. Particle effects are commonly used to simulate fire, 
smoke, steam and other fluids, or to control complex animations such as 
crowd scenes. 

Plane A two-dimensional surface in Cartesian co-ordinate space. Essentially a flat 
sheet extending infinitely in all directions, a plane may be used to aid object 
manipulation, positioning and construction, and is not usually made visible in 
a final render. 

Plugin A small piece of third-party software that is loaded into a 3D application in 
order to extend its functionality. Plugins commonly perform such specialist 
tasks as file conversion or data export, texture generation, and physics or fluid 
simulation. There are thousands of plugins currently available on the Internet, 
both commercially and as free downloads. 

Point A one-dimensional point in coordinate space. Points can be linked up to form 
polygons, used as control vertices for NURBS curves, or employed as nulls to 
control lights or cameras, amongst other functions. 

Polygon A geometry element formed by connecting three or more points. A triangle, or 
three-point polygon, is the simplest form of polygonal geometry. Polygonal 
modelling is a fast, intuitive method of creating 3D objects, but does not easily 
generate smooth curved surfaces. 

Post Processing The manipulation of a rendered image, either to improve the quality of that 
image, or to create effects that cannot easily be achieved directly within the 
3D software itself. Some 3D software packages can be set to automatically 
apply post-processing effects, such as motion blur or Depth of Field, after a 
frame is rendered. 

Preset A pre-generated list of settings for a particular 3D software package. Presets 
are usually used to control and customise properties such as rendering or 
lighting styles. Like plugins, they may either be commercial products, or freely 
downloadable from the Internet. 

Preview A time-saving method of checking the progress of a project by rendering it at 
a lower quality, resolution or frame rate than will be used for the final project. 
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Primitive A simple three-dimensional form used as the basis for constructive solid 
geometry modelling techniques. Typical primitives include the plane, the 
cube, the sphere, the cone and the torus. 

Procedural Texture A texture map that is generated by a mathematical function, rather than a 
real-world bitmap image projected over the surface of an object. 

Projection The process by which a two-dimensional texture map is applied over the 
surface of a three-dimensional object, as if it were an image projected from a 
slide projector. There are several common projection types, including Planar, 
Cubic, Spherical and Cylindrical. Which one is most appropriate depends on 
the type of map being projected, and the shape of the object it is being 
projected upon. 

Radiosity A technique for rendering 3D scenes. Radiosity simulates the way in which 
light bounces from surface to surface within a scene, and is more accurate, 
but also more processor-intensive, than raytracing. 

Raytracing A technique for rendering 3D scenes. Raytracing traces the path of every ray 
of light from its source until it either leaves the scene or becomes too weak to 
have an effect. The term is also sometimes applied to the reverse method: 
tracing the path of every ray of light from the camera backwards to the light 
source. 

Reflection Map An environment map used to simulate real-world reflection effects on the 
surface of a 3D object. Reflection maps render more quickly than methods 
that generate true surface reflections, such as raytracing. 

Rendering The process of converting the 3D data stored in a software package into the 
two-dimensional image ‘seen’ by the camera within the scene. Rendering 
brings together the scene geometry, Z-depth, surface properties, lighting set-
up and rendering method to create a finished frame. Rendering comes in two 
forms: Display or Hardware rendering, used to display the scene on-screen in 
the software package’s viewports; and the more processor intensive Final-
quality or Software rendering, which generates an image for output, and takes 
account of properties that Display rendering overlooks, such as shadows, 
reflections and post-process effects. 

Resolution The size of the final image in pixels when rendering out a scene. Higher 
resolution renders contain more detail, but take longer to complete. 

Scene A set of 3D objects, including the models themselves and the lights and 
camera that will be used when rendering them out. 
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Shading The mathematical process of calculating how a model’s surfaces react to 
light. A variety of alternative algorithms can be used for the task, including 
Phong, Lambert, and Blinn shading models. Shaders are often built up as 
node-based shading trees, with each node controlling a specific aspect of the 
process. 

Snapping The automatic alignment of one object to another or to a reference grid, 
intended to aid the precise placement of objects within a scene or modelling 
hierarchy. 

Specularity A surface property of an object that determines the way in which highlights 
appear on that surface. 

Symmetry A modelling option in which any changes made to the model are duplicated 
across an axis of reflectional symmetry. This makes it possible to create 
complex symmetrical objects, such as a human or animal head, without 
having to work directly on more than one half of the model. 

Texture A bitmap image that is applied to the surface of 3D object to give it detail. 
Texture maps may be either photographic images or procedural textures, and 
may be applied in each of the material channels of an object using a variety of 
mapping or projection methods. 

Three-Point Lighting A system of CG lighting derived from real-world cinematography, in which a 
scene is illuminated by three light sources: a Key light, which acts as the 
primary source of illumination for the scene; a Fill light, which illuminates 
shadow areas; and a Rim light, which illuminates the edges of objects and 
helps them stand out from the background. 

Tiling The process of duplicating a texture across the surface of an object. Tiling 
textures must be created so that the edge of one aligns perfectly with that of 
its neighbor, otherwise the result is a series of ugly seams. High frequency 
textures are those in which patterns repeat at short intervals over an object’s 
surface; low-frequency textures are those in which the intervals are larger. 

Timeline A fundamental element of the graphical user interface of most modern 3D 
software packages which shows the timing of the keyframes in a sequence of 
animation. Playback of the animation may be controlled either by a series of 
VCR-like controls, or by clicking and dragging with the mouse to ‘scrub’ a 
slider to and fro along the timeline. 

UV Texture Co-
ordinates

The co-ordinate system used for assigning textures to polygonal models. 
Since UV co-ordinate space is two-dimensional, one of several projection 
methods must be used to ‘unwrap’ the UVs from the model and lay them flat 
on a plane. Once unwrapped, the UV map may be screen grabbed and 
exported to a paint package for texture painting. 
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Vertex See: Point.

Viewport The region of the interface of a 3D software package in which the scene is 
displayed to the artist. 

Wireframe A shading method in which a simple grid of lines is used to represent the 
basic contours of the underlying model. For many 3D artists, this is a favoured 
mode to work in, since it permits them to see faces and surfaces that would 
otherwise be hidden by overlying geometry. 

World axes See: Co-ordinate systems.

Z-depth The distance a particular point or surface lies inside a scene. Z-depth 
information is used to calculate where a light casts shadows, and also to 
calculate which surfaces are visible to the camera during rendering, and 
which are obscured by nearer geometry. 
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